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Safety Instructions

Important Safety Instructions

Read all of the instructions in this section before using the printer. Also, be sure to follow 
all warnings and instructions marked on the printer.

Setting Up the Printer

Observe the following when setting up the printer:

❏ Do not block or cover the vents and openings in the printer.

❏ Use only the type of power source indicated on the printer’s label.

❏ Use only the power cord that comes with the printer. Use of another cord may result in 
fire or electric shock.

❏ The printer’s power cord is for use with the printer only. Use with other equipment may 
result in fire or electric shock.

❏ Be sure your AC power cord meets the relevant local safety standard.

❏ Avoid using outlets on the same circuit as photocopiers or air control systems that 
regularly switch on and off.

❏ Avoid electrical outlets controlled by wall switches or automatic timers.

❏ Keep the entire computer system away from potential sources of electromagnetic 
interference, such as loudspeakers or the base units of cordless telephones.

❏ Do not use a damaged or frayed power cord.

❏ If you use an extension cord with the printer, make sure that the total ampere rating of 
the devices plugged into the extension cord does not exceed the cord’s ampere rating. 
Also, make sure that the total ampere rating of all devices plugged into the wall outlet 
does not exceed the wall outlet’s ampere rating.

❏ Do not attempt to service the printer yourself.



Safety Instructions 10

❏ Unplug the printer and refer servicing to qualified service personnel under the following 
conditions: 
The power cord or plug is damaged; liquid has entered the printer; the printer has been 
dropped or the casing damaged; the printer does not operate normally or exhibits a 
distinct change in performance.

❏ When connecting the printer to a computer or other device with a cable, ensure the 
correct orientation of the connectors. Each connector has only one correct orientation. 
Inserting a connector in the wrong orientation may damage both devices connected by 
the cable.

❏ If damage occurs to the plug, replace the cord set or consult a qualified electrician. If 
there are fuses in the plug, make sure you replace them with fuses of the correct size 
and rating.

❏ Do not hold the duplex unit when you lift the printer to prevent the duplex unit from 
becoming detached. Also, make sure that the duplex unit is attached correctly after 
setting up the printer.

Choosing a Place for the Printer

Observe the following when choosing a place for the printer:

❏ Place the printer on a flat, stable surface that extends beyond the base of the printer in 
all directions. If you place the printer by the wall, leave at least 4 inches (10 cm) 
between the back of the printer and the wall. The printer will not operate properly if it is 
tilted at an angle.

❏ When storing or transporting the printer, do not tilt it, stand it on its side, or turn it upside 
down. Otherwise, ink may leak from the ink packs.

❏ Leave enough space in front of the printer for the paper to be fully ejected.

❏ Avoid places subject to rapid changes in temperature and humidity. Also, keep the 
printer away from direct sunlight, strong light, or heat sources.

❏ Avoid places subject to dust, shocks, or vibrations.

❏ Leave enough room around the printer to allow for sufficient ventilation.

❏ Place the printer near a wall outlet where the plug can be easily unplugged.

Using the Printer

Observe the following when using the printer:
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❏ Avoid touching the components inside the printer unless instructed to do so in this 
guide.

❏ Do not insert objects through the slots in the printer.

❏ Take care not to spill liquid on the printer.

❏ Do not touch the white flat cable inside the printer.

❏ Do not put your hand inside the printer during printing.

❏ Do not use aerosol products that contain flammable gases inside or around this 
product. Doing so may cause fire.

❏ Do not move the print head by hand; otherwise, you may damage the printer.

❏ Do not move the cartridge lever during printing.

❏ Always turn off the printer using the P Power button. When this button is pressed, the 
P Power light flashes. Do not unplug the printer or turn off the power to the outlet until 
the P Power light stops flashing.

❏ Before transporting the printer, make sure that the print head is in the home (far right) 
position.

❏ Be careful not to trap your fingers when closing the printer cover.

Handling Ink Cartridges

Observe the following when handling ink cartridges:

❏ Keep ink cartridges out of the reach of children and do not drink the ink.

❏ If ink gets on your skin, wash it off with soap and water. If it gets in your eyes, flush them 
immediately with water.
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❏ Shake the ink cartridge for 5 seconds before installing it for best results.

c
Caution:
Do not shake cartridges (that have been installed previously) with too much force.

❏ Do not use an ink cartridge beyond the date printed on the cartridge carton.

❏ Use up the ink cartridge within six months of installation for best results.

❏ Do not disassemble or modify the ink cartridge. This may affect normal operation and 
printing.

❏ Store ink cartridges in a cool, dark place.

❏ After bringing an ink cartridge inside from a cold storage site, allow it to warm up at 
room temperature for at least three hours before using it.

❏ Do not touch the green IC chip on the side of the cartridge. This may affect normal 
operation and printing. The IC chip on this ink cartridge retains a variety of cartridge 
related-information, such as the ink cartridge status, so that the cartridge may be 
removed and reinserted freely. However, each time the cartridge is inserted, some ink 
is consumed because the printer automatically performs a reliability check. If you 
remove an ink cartridge for later use, protect the ink supply area from dirt and dust, and 
store it in the same environment as this product. Note that there is a valve in the ink 
supply port, making covers or plugs unnecessary, but care is needed to prevent the ink 
from staining items that the cartridge touches. Do not touch the ink supply port or 
surrounding area.

Warnings, Cautions, and Notes

Warnings, Cautions, and Notes in this User’s Guide are defined as follows:

w
Warnings
must be followed carefully to avoid bodily injury.
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c
Cautions
must be observed to avoid damage to your equipment.

Notes
contain important information and useful tips on the operation of the printer.
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Chapter 1 

Using Your Software

Overview of Printer Driver and Status Monitor

The printer driver lets you choose from a wide variety of settings to get the best printing 
results. Status Monitor and the printer utilities help you check the printer and keep it in top 
operating condition.

Accessing the Printer Driver for Windows

You can access the printer driver from most Windows® applications, the Windows Start 
menu, or the taskbar.

To make settings that apply only to the application you are using, access the printer driver 
from that application.

To make settings that apply to all of your Windows applications, access the printer driver 
from the Start menu or the taskbar.

Refer to the following sections to access the printer driver.

Note:
Screen shots of the printer driver windows in this User's Guide are from Windows XP.

From Windows Applications

1. Click Print or Print Setup on the File menu.

2. In the window that appears, click Printer, Setup, Options, Preferences, or 
Properties. (Depending on your application, you may need to click one or a 
combination of these buttons.) 

From the Start Menu

1. Windows 7:
Click the Start button, and select Devices and Printers. 

Windows Vista® and Server 2008:
Click the Start button, select Control Panel, and then select Printer from the 
Hardware and Sound category. (If the Control Panel is in Classic View, click Printers.)
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Windows XP and Server 2003:
Click Start, Control Panel, then click Printers and Faxes. (If the Control Panel is in 
Category View, click Printers and Other Hardware, then click Printers and Faxes.) 

Windows 2000:
Click Start, point to Settings, then click Printers.

2. Windows 7:
Right-click the icon the printer and select Printing preferences.

Windows Vista and Server 2008:
Select the printer and then click Select printing preferences.

Windows XP, Server 2003, and 2000:
Select the printer, then click Printing Preferences on the File menu.

From the Shortcut Icon on the Taskbar

Right-click the printer icon on the taskbar, then select Printer Settings.

To add a shortcut icon to the Windows taskbar, first access the printer driver from the Start 
menu as described above. Next, click the Maintenance tab, the Speed & Progress 
button, and then the Monitoring Preferences button. In the Monitoring Preferences 
window, select the Select Shortcut Icon check box.

Getting Information through Online Help

You can access online help for items in the printer driver from your application or the 
Windows Start menu.
& See “Accessing the Printer Driver for Windows” on page 14.

In the printer driver window, try one of the following procedures:

❏ Right-click the item, then click Help.

❏ Click the  button at the top right of the window, then click the item (for Windows XP 
and 2000 only).

Accessing the Printer Driver for Mac OS X

The table below describes how to access the printer driver dialog.



Using Your Software 16

Getting information through online help

Click the  Help button in the Print dialog.

Uninstalling the Printer Software

Uninstalling the Printer Driver

You may need to uninstall your printer driver if you:

❏ Upgrade your computer’s operating system.

❏ Update your printer driver with a newer version.

❏ Have a problem with the printer driver.

If you are upgrading your operating system or updating the printer driver version, be sure 
to uninstall the current printer driver before upgrading or installing the new driver. 
Otherwise, the driver update will not work.

Dialog How to Access It

Page Setup Click Page Setup on the File menu of your application.

Note for Mac OS® X 10.5 and 10.6:
Depending on your application, the Page Setup menu may not 
appear in the File menu.

Print Click Print on the File menu of your application.

EPSON Printer 
Utility3

You can access this software in the following three ways:

❏ Double-click the EPSON Printer Utility3 icon in the Applications 
folder in Macintosh HD. Select the printer from the Printer List, then 
click OK.

❏ Click Print from your application’s File menu, choose Print Settings in 
the Print window that is displayed, then click the  Utility icon. This 
Utility icon is not displayed when the printer is shared.

❏ For Mac OS X 10.4 only
Open the Applications folder on your hard drive, then open the 
Utilities folder and double-click the Print Center or Printer Setup 
Utility icon. Select the appropriate printer from the list, then click the 
Configure or Utility button.
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For Windows

Note:
❏ To uninstall programs in Windows 7 and Windows Vista, you need an administrator account 

and the password if you log on as a standard user.

❏ To uninstall programs in Windows XP, you must log on to a Computer Administrator account.

❏ To uninstall programs in Windows 2000, you must log on as a user with administrative 
privileges (belonging to the Administrators group).

1. Turn off the printer and disconnect its interface cable.

2. Windows 7 and Windows Vista and Server 2008:
Click the Start button and select Control Panel.

Windows XP and Server 2003:
Click Start and select Control Panel.

Windows 2000:
Click Start, point to Settings, and select Control Panel.

3. Windows 7 and Windows Vista and Server 2008:
Click Uninstall a program from the Programs category, and then select EPSON 
Printer Software from the list.

Windows XP and 2000:
Select Add/Remove Programs and then select EPSON Printer Software from the list.

4. Windows 7 and Windows Vista and Server 2008:
Click Uninstall/Change.

Windows XP, Server 2003, and 2000:
Click Change/Remove.

5. Select the icon for your printer and click OK.

6. Click OK to uninstall the printer driver.

For Mac OS X

Note:
To uninstall the programs, you must log on to a Computer Administrator account. You cannot 
uninstall programs if you log on as a Limited account user.

1. Quit all running applications.

2. Insert the Epson printer software CD-ROM into your Macintosh.
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3. Double-click the Mac OS X icon in the Epson folder. The CD Installer screen is 
displayed. Click Custom Install.

4. Select Printer Driver.

Note:
If the Authenticate dialog appears, enter your password or phrase and click OK.

5. Read the software license agreement and click Accept.

6. Select Uninstall from the menu in the upper left and click Uninstall.

7. Follow the on-screen instructions to uninstall the printer driver.

Note for Mac OS X 10.4:
If the name of your printer remains in the Print Center or Printer Setup Utility, select the name from 
Printer List and click Delete.

Uninstalling the User’s Guide

For Windows

Note:
❏ To uninstall programs in Windows 7 and Windows Vista, you need an administrator account 

and the password if you log on as a standard user.

❏ To uninstall programs in Windows XP, you must log on to a Computer Administrator account.

❏ To uninstall programs in Windows 2000, you must log on as a user with administrative 
privileges (belonging to the Administrators group).

1. Turn off the printer and disconnect its interface cable.

2. Windows 7 and Windows Vista and Server 2008:
Click the Start button and select Control Panel.

Windows XP and Server 2003:
Click Start, then select Control Panel.

Windows 2000:
Click Start, point to Settings, and select Control Panel.

3. Windows 7 and Windows Vista and Server 2008:
Click Uninstall a program from the Programs category.

Windows XP, Server 2003, and 2000:
Select Add or Remove Programs.
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4. Select this printer’s Manual from the list.

5. Windows 7 and Windows Vista and Server 2008:
Click Uninstall/Change.

Windows XP, Server 2003, and 2000:
Click Change/Remove.

6. Click OK.

For Mac OS X

Note:
To uninstall the programs, you must log on to a Computer Administrator account. You cannot 
uninstall programs if you log on as a Limited account user.

1. Quit all running applications.

2. Insert the Epson printer software CD-ROM into your Macintosh.

3. Double-click the Mac OS X icon in the Epson folder. The CD Installer screen is 
displayed. Click Custom Install.

4. Select User’s Guide.

5. Select Uninstall from the menu in the upper left and click Uninstall.

6. Follow the on-screen instructions to uninstall the User’s Guide.
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Chapter 2 

Paper Handling

Using Special Paper

You can achieve best results with most types of plain bond paper. However, coated papers 
can also be used.

Epson provides special papers that are formulated for the ink used in Epson ink jet printers, 
and recommends these papers to ensure high-quality results.

& See “Paper, Consumables, and Options” on page 167.

When loading special paper distributed by Epson, read the instruction sheets packed with 
the paper first and keep the following points in mind.

Note:
❏ Load the paper into the rear sheet feeder printable side up, and in the front paper cassette 

printable side down. The printable side is usually whiter or glossier. See the instruction sheets 
packed with the paper for more information.

❏ If the paper is curled, flatten it or curl it slightly in the opposite direction before loading. Printing 
on curled paper may cause ink to smear on your printout.

❏ Avoid using coated color-laser paper, which can lead to unsatisfactory results.

Paper Loading Capacities 

Refer to the table below for the loading capacities of Epson special paper and other paper. 

Front paper cassette:

Media Type Loading Capacity

Epson Bright White Paper Up to 400 sheets 
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Rear sheet feeder:

Note:
❏ If the paper is curled, flatten it or curl it slightly in the opposite direction. Make sure the paper 

stack fits under the c arrow mark inside the edge guide.

❏ Maximum capacity for plain paper depends on the weight and thickness of the paper.

❏ The output tray has a maximum capacity of 170 sheets.

You can purchase genuine Epson ink and paper at Epson Supplies CentralSM at 
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also purchase 
supplies from an Epson authorized reseller. To find the nearest one, call 800-GO-EPSON 
(800-463-7766).

Loading Paper

Follow these steps to load paper:

Plain paper Up to 510 sheets

Media Type Loading Capacity

Plain paper (letter-size) Up to 150 sheets 

Plain paper (legal-size) 1 sheet at a time (up to 60 
sheets with the optional 
legal-size paper support)

Epson Bright White Paper Up to 100 (70 sheets for manual 
double-sided printing)

Epson Premium Presentation Paper Matte Up to 20 sheets

Epson Premium Presentation Paper Matte 
Double-Sided

1 sheet at a time

Epson Photo Quality Self Adhesive Sheets 1 sheet at a time

Epson Presentation Paper Matte Up to 100 sheets

Envelopes Up to 15 envelopes

www.epson.ca
www.epson.com/ink
www.epson.com/ink
www.epson.ca
http://www.epson.ca
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Front Paper Cassette

1. Pull out the front paper cassette.

Note:
❏ The B-310N and the standard-sized front paper cassette are shown throughout.

❏ If the legal-size paper cassette (optional for the B-310N) is attached instead of the front 
paper cassette, raise its cover and flip it open.

2. Squeeze the edge guides and slide them out until they click into place.

3. Fan a stack of paper, then tap it on a flat surface to even the edges.

MODIFY TO SHOW LETTER SIZE
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4. Load the paper with the printable side down.

Note:
Avoid adding paper in the middle of print jobs. Doing so may prevent the paper from feeding 
smoothly.

5. Squeeze the edge guides and slide them against the paper until they click.

Note:
If the legal-size paper cassette is attached instead of the front paper cassette, close its cover.

6. Gently reinsert the cassette into the printer.
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c
Caution:
To avoid paper jams, do not force the front paper cassette or legal size paper cassette 
into the printer and check the edge guides after inserting the cassette.

7. Slide out and extend the extension tray.

Note:
❏ Leave enough space in front of the printer for the paper to be fully ejected.

❏ Make sure the paper stack fits under the c arrow mark inside the left edge guide.

❏ The legal size paper cassette does not align flush with the output tray.

Rear Sheet Feeder

1. Open the paper support.

2. Slide out and extend the extension tray.
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3. Slide the edge guide to the left.

4. Fan a stack of paper, then tap it on a flat surface to even the edges.

5. Load the paper with the printable side up, against the right side of the rear sheet feeder. 
Then slide the edge guide against the left edge of the paper.

Note:
❏ Leave enough space in front of the printer for the paper to be fully ejected.

❏ Always load paper into the rear sheet feeder short edge first, even when you are printing 
landscape-oriented pictures.

❏ Avoid adding paper in the middle of print jobs. Doing so may prevent the paper from feeding 
smoothly.

❏ Make sure the paper stack fits under the c arrow mark inside the left edge guide.
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Using the Optional Legal-Size Paper Support

Align the legal-size paper support with the right side of the paper support and attach it as 
shown. You can load up to 60 sheets of plain legal-size paper (up to 20 lb or 75 g/m²).

Do not leave legal-size paper in the rear sheet feeder when you are not printing, or the 
sheets may curl.

Loading Envelopes

Follow these steps to load envelopes:

1. Open the paper support.
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2. Slide out and extend the extension tray.

3. Slide the left edge guide to the left.

4. Load envelopes short edge first with the flap facing down and to the left. Then slide the 
left edge guide against the left edge of the envelopes.

Note:
❏ The thickness of envelopes and their ability to fold vary widely. If the total thickness of the stack 

of envelopes exceeds 0.6 inch (15 mm), press down on the envelopes to flatten them before 
loading. If print quality declines when a stack of envelopes is loaded, load one envelope at a 
time.

❏ You can load up to 15 envelopes at a time in the rear sheet feeder.
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❏ Do not use envelopes that are curled or folded.

❏ Flatten the envelope flaps before loading.

❏ Flatten the leading edge of the envelope before loading.

❏ Avoid using envelopes that are too thin, as they may curl during printing.

For printing instructions, see the following instructions.
& See “Printing on Envelopes” on page 42.

Setting Up the Output Tray

The output tray is located on the front paper cassette. Slide out the extension tray and then 
open the flap on the extension tray to prevent your prints from slipping off the printer. The 
maximum capacity of the output tray is 170 sheets.

Selecting the Correct Paper Type or Media Type

The printer automatically adjusts itself for the type of paper you select in your print settings. 
That is why the paper type or media type setting is so important. It tells your printer what 
kind of paper you are using and adjusts the ink coverage accordingly. The table below lists 
the settings you should choose for your paper.

For this paper Select this paper type (media 
type) setting

Plain paper Plain Paper/Bright White Paper

Epson Bright White Paper

Epson Premium Presentation Paper Matte Premium Presentation Paper 
Matte

Epson Premium Presentation Paper Matte 
Double-Sided

Epson Presentation Paper Matte Presentation Paper Matte

Envelopes Envelope
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Chapter 3 

Basic Printing

Introduction

This section guides you through the procedures for different kinds of printing.

Printing Documents

Explains how to print documents on various types of paper.
& See “Printing Documents” on page 30.

Printing Photos

Explains how to print photos on various types of paper.
& See “Printing Photos” on page 36.
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Printing on Envelopes

Explains how to print on envelopes.
& See “Printing on Envelopes” on page 42.

Printing Documents

Loading Paper

Refer to the section below for details on loading paper.

& See “Loading Paper” on page 21.

When using special Epson paper, refer to the section below.

& See “Using Special Paper” on page 20.

Printer Settings for Windows

1. Open the file you want to print.

2. Access the printer settings.
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& See “Accessing the Printer Driver for Windows” on page 14.

3. Click the Main tab, then select one of the following Quality Option settings:

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only documents with higher text quality

❏ Text & Image for higher quality documents with text and images

4. Select the paper source as the Source setting.

5. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

6. Select the appropriate Size setting. You can also define a custom paper size. For 
details, see the online help.

7. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

8. Click OK to close the printer settings window.
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9. Print your file.

Note:
You can also print on both sides of the paper.

& See “Double-Sided (Duplex) Printing” on page 51.

Printer Settings for Mac OS X 10.5 and 10.6

Follow these steps to adjust your printer settings.

1. Open the file you want to print.

2. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

3. Click the d button to extend this dialog.
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4. Select the printer you are using as the Printer setting, and then make suitable settings.

Note:
Depending on your application, you may not be able to select some of the items in this dialog. 
If so, click Page Setup on the File menu of your application, and then make suitable settings.
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5. Select Print Settings from the pop-up menu.

6. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

7. Click Print to start printing.

Printer Settings for Mac OS X 10.4

1. Open the file you want to print.

2. Access the Page Setup dialog.
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& See “Accessing the Printer Driver for Mac OS X” on page 15.

3. Select the printer you are using as the Format for setting, and then make suitable 
settings.

4. Click OK to close the Page Setup dialog.

5. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

6. Select the printer you are using as the Printer setting. Then make the Copies & Pages 
settings.
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7. Select Print Settings from the pop-up menu.

8. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

9. Click Print to start printing.

Printing Photos

Preparing the Print File

You need to adjust the image file to the size of the paper. If your application has margin 
settings, make sure that the margins are within the printable area of the page. 
& See “Printable Area” on page 171.
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Loading Paper

Refer to the section below for details on loading paper.

& See “Loading Paper” on page 21.

When using special Epson paper, refer to the section below.

& See “Using Special Paper” on page 20.

Printer Settings for Windows

Follow these steps to adjust your printer settings.

1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select Photo in the Quality Option settings.
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3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

5. Select the appropriate Size setting. You can also define a custom paper size. For 
details, see the online help.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Printer Settings for Mac OS X 10.5 and 10.6

Follow these steps to adjust your printer settings.

1. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the d button to extend this dialog.
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3. Select the printer you are using as the Printer setting, and then make suitable settings.

Note:
Depending on your application, you may not be able to select some of the items in this dialog. 
If so, click Page Setup on the File menu of your application, and then make suitable settings.
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4. Select Print Settings from the pop-up menu.

5. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Printer Settings for Mac OS X 10.4

Follow these steps to adjust your printer settings.

1. Access the Page Setup dialog.
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& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Select the printer you are using as the Format for setting, and then make suitable 
settings.

3. Click OK to close the Page Setup dialog.

4. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

5. Select the printer you are using as the Printer setting. Then make the Copies & Pages 
settings.
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6. Select Print Settings from the pop-up menu.

7. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Printing on Envelopes

Loading Envelopes

Refer to the section below for loading envelopes.
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& See “Loading Envelopes” on page 26.

Refer to the section below for the printable area.

& See “Printable Area” on page 171.

Printer Settings for Windows

1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings: 

❏ Text for most envelopes

❏ Text & Image to print images on the envelope

3. Select Rear Tray as the Source setting.

4. Select Envelope as the Type setting.
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5. Select the appropriate envelope size from the available Size settings. You can also 
define a custom size. For details, see the online help.

6. Select Landscape as the Orientation setting.

7. Click OK to close the printer settings window.

8. Print your envelope.

Printer Settings for Mac OS X 10.5 and 10.6

Follow these steps to adjust your printer settings.

1. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the d button to extend this dialog.

3. Select the printer you are using as the Printer setting, and then select a suitable 
envelope size as the Paper Size setting. You can also define a custom envelope size. 
For details, see the online help.
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4. Select Landscape as the Orientation setting.

Note:
Depending on your application, you may not be able to select some of the items in this dialog. 
If so, click Page Setup on the File menu of your application, and then make suitable settings.
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5. Select Print Settings from the pop-up menu.

6. Select Envelope as the Media Type setting.

7. Make other settings that you want to use to print. See online help for details of Print 
Settings.

8. Click Print to start printing.

Printer Settings for Mac OS X 10.4

1. Access the Page Setup dialog.
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& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Select the printer you are using as the Format for setting.

3. Select the appropriate envelope size as the Paper Size setting. You can also define a 
custom envelope size. For details, see the online help.

4. Select Landscape as the Orientation setting.

5. Click OK to close the Page Setup dialog.

6. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

7. Select the printer you are using as the Printer setting, then make the Copies & Pages 
settings.
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8. Select Print Settings from the pop-up menu.

9. Select Envelope as the Media Type setting.

10.Make other settings that you want to use to print. See online help for details of Print 
Settings.

11.Click Print to start printing.

Canceling Printing

If you need to cancel printing, follow the instructions in the appropriate section below.

Using the Cancel Button on the Printer

Press the + Cancel button to cancel a print job in progress.

Canceling from Windows

When you start printing, the progress meter appears on your computer screen.
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Click the Stop button to cancel printing.

Canceling from Mac OS X

Follow the steps below to cancel a print job.

1. Click your printer icon in the Dock.

2. In the Document Name list, select the document that is printing.
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3. Click the Delete button to cancel the print job.
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Chapter 4 

Printing with Special Layout Options

Introduction 

You can print with a variety of layouts for special projects, such as booklets and posters.

Double-Sided (Duplex) Printing

Lets you print on both sides of the paper.
& See “Double-sided (Duplex) Printing” on page 53.

Fit to Page Printing

Lets you automatically enlarge or reduce the size of your document to fit the paper size 
selected in the printer driver.
& See “Fit to Page Printing” on page 73.
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Pages Per Sheet Printing

Lets you print two or four pages on a single sheet of paper.
& See “Pages Per Sheet Printing” on page 81.

Poster Printing (for Windows only)

Lets you enlarge material on a single document page to cover 4, 9, or 16 printed sheets of 
paper, and then make a poster.
& See “Poster Printing (for Windows only)” on page 89.

Watermark Printing (for Windows only)

Lets you print text or an image as a watermark on each page of your printout.
& See “Watermark Printing (for Windows only)” on page 94.
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For example, you can put “Confidential” on an important document.

Double-sided (Duplex) Printing

Two types of double-sided printing are available: standard and folded booklet.

Standard double-sided printing lets you automatically print on both sides of the page (on 
plain paper only), using the duplex unit. 

Without the duplex unit, you can print the odd-numbered pages first. Once these pages are 
printed, you can reload them to print the even-numbered pages onto the opposite side of 
the paper.
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Folded booklet double-sided printing allows you to make single-fold booklets. The pages 
that will appear on the outside (after the page is folded) are printed first. The pages that will 
appear inside the booklet can then be printed after you reload the paper into the printer.

✽: Binding edge

You can create a booklet by printing pages 1 and 4 on the first sheet of paper, pages 5 and 
8 on the second sheet, and pages 9 and 12 on the third sheet.

After you reload these sheets into the rear sheet feeder, you can then print pages 2 and 3 
on the back of the first sheet of paper, pages 6 and 7 on the back of the second sheet, and 
pages 10 and 11 on the back of the third sheet.

The resulting pages can then be folded and bound together into a booklet.

Note:
❏ Depending on the paper, stacks of up to 30 sheets can be loaded into the rear sheet feeder 

during double-sided printing.

❏ Only use papers that are suitable for double-sided printing. Otherwise, the printout quality may 
deteriorate.

❏ Depending on the paper and the amount of ink used to print text and images, ink may bleed 
through to the other side of the paper.

❏ The surface of the paper may be smeared during double-sided printing.
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Standard Double-sided Printing for Windows

Automatic Double-sided Printing (Using the Duplex Unit)

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the 
sheet using the duplex unit.

Note:
The duplex unit is standard on the B-510DN and available as an option for the B-310N. Automatic 
double-sided printing supports plain paper and Epson Bright White Paper only. Thick plain paper is 
not supported for automatic double-sided printing.

1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings:

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages
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❏ Text & Image for higher quality pages with text and images

❏ Graphic for higher quality graphics

❏ Photo for good quality and speed

3. Select the paper source as the Source setting.

4. Select Plain Paper/Bright White Paper as the Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

5. Select the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Select 2-sided printing, Auto. 

8. Click OK to save your settings.

9. Click OK or Print to start printing.

Note:
Do not try to pull out your prints before both sides of the page are printed.

Special Settings for Automatic Double-sided Printing (Using the Duplex 
Unit)

When you print photos or heavy text on both sides of the page, you can adjust the print 
density and drying time to prevent ink from bleeding through to the other side. You can also 
adjust the margins to allow for binding your pages.

Note:
Automatic double-sided printing supports plain paper and Epson Bright White Paper only.

1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Select the appropriate Quality Option, Paper Options, and Orientation.

& See “Automatic Double-sided Printing (Using the Duplex Unit)” on page 55.
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3. Click the Page Layout tab.

4. Select Auto under 2-sided printing to use the automatic double-sided printing 
function.

5. Click Adjust Print Density to open the Print Density Adjustment window.

6. Select the appropriate document type as the Select Document Type setting.
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7. Specify the Print Density and Increased Ink Drying Time as the Adjustments setting.

Note:
When you print dense photos on both sides of the paper, reduce the print density and increase 
the drying time to improve quality.

8. Click OK to return to the Page Layout window.

9. Click Margins to open the Margins window.

10.Specify the edge of the paper where the binding will be placed. You can choose Left, 
Top, or Right.

11.Choose cm or inch as the Unit setting. Then specify the width of the binding margin. 
You can enter any width from 0.12 to 1.18 inches or 0.3 to 3.0 cm.

Note:
The actual binding margin may be different from the specified settings depending on your 
application. Experiment with a few sheets to examine actual results before printing the entire 
job.

12.Click OK to return to the Page Layout window. Then click OK to save your settings.

13.Load paper into the printer, then send the print job from your application.

& See “Loading Paper” on page 21.

Note:
Do not try to pull out your prints before both sides of the page are printed.

Manual Double-sided Printing

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the 
sheet.
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1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings:

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages

❏ Text & Image for higher quality pages with text and images

❏ Graphic for higher quality graphics

❏ Photo for good quality and speed

3. Select Rear Tray as the Source setting.

4. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 28.
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5. Select the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab.

8. Select Manual under 2-sided printing to use manual double-sided printing function.

9. Click Margins to open the Margins window.
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10.Specify the edge of the paper where the binding will be placed. You can choose Left, 
Top, or Right.

11.Choose cm or inch as the Unit setting. Then specify the width of the binding margin. 
You can enter any width from 0.12 to 1.18 inches, or from 0.3 to 3.0 cm.

Note:
The actual binding margin may be different from the specified settings depending on your 
application. Experiment with a few sheets to examine actual results before printing the entire 
job.

12.Click OK to return to the Page Layout window. Then click OK to save your settings.

13.Load paper into the rear sheet feeder, then send the print job from your application. 
Instructions for generating the even-numbered pages will be displayed while the 
odd-numbered pages are printed.

& See “Loading Paper” on page 21.

14.Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink used. Should this occur, slightly 

curl the sheets in the opposite direction before reloading them.

❏ Align the sheet stack by tapping its edges against a hard, flat surface before reloading the 
stack.

❏ Follow the on-screen instructions when reloading the printouts. Otherwise, paper may jam 
or the binding margins may be incorrect.

❏ If a paper jam occurs, refer to the following.
& See “The Paper Jams” on page 148.

15.Once the paper is reloaded, click Resume to print the even-numbered pages.

Standard Double-sided Printing for Mac OS X 10.5 and 10.6

Automatic Double-sided Printing (Using the Duplex Unit)

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the 
sheet using the duplex unit.

Note:
❏ Automatic double-sided printing supports plain paper only.

❏ Thick plain paper is not supported for automatic double-sided printing.
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1. Access the EPSON Printer Utility3 dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the Printer and Option Information button.
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3. Make sure that Duplexer Installed is displayed in the Auto Duplex Printing Information 
section, and then click OK.

4. Close the EPSON Printer Utility3 dialog.

5. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

6. Click the d button to extend this dialog.
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7. Select the printer you are using as the Printer setting, and then make suitable settings.

Note:
Depending on your application, you may not be able to select some of the items in this dialog. 
If so, click Page Setup on the File menu of your application, and then make suitable settings.
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8. Select Print Settings from the pop-up menu.

9. Select Plain Paper/Bright White Paper as the Media Type setting.

10.Make other settings that you want to use to print. See online help for details of Print 
Settings.
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11.Select 2-sided Printing Settings from the pop-up menu.

12.Select the 2-sided Printing check box.

13.Select the Binding edge setting.

14.Select one of the Document Type settings. This automatically adjusts Print Density and 
Ink Drying Time.

Note:
If you are printing high-density data, such as photos or graphs, we recommend adjusting the 
Print Density.

15.Load paper into the printer, and click Print.

& See “Loading Paper” on page 21.
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Standard Double-sided Printing for Mac OS X 10.4

Automatic Double-sided Printing (Using the Duplex Unit)

Follow the steps below to print odd- and even-numbered pages onto opposite sides of the 
sheet using the duplex unit.

Note:
❏ Automatic double-sided printing supports plain paper only.

❏ Thick plain paper is not supported for automatic double-sided printing.

1. Access the EPSON Printer Utility3 dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the Printer and Option Information button.

3. Make sure that Duplexer Installed is displayed in the Auto Duplex Printing Information 
section, and then click OK.

4. Close the EPSON Printer Utility3 dialog.

5. Access the Page Setup dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

6. Select the printer you are using as the Format for setting.

7. Select A4, Letter, or B5 as the Paper Size setting. 

8. Select the appropriate Orientation setting, and click OK to close the Page Setup dialog.
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9. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

10.Select Print Settings from the pop-up menu.

11.Select Plain Paper / Bright White Paper as the Media Type setting.

12.Make the settings that you want to use to print. See online help for details of Print 
Settings.
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13.Select 2-sided Printing Settings from the pop-up menu.

14.Select the 2-sided Printing check box.

15.Select the Binding edge setting.

16.Select one of the Document Type settings. This automatically adjusts Print Density and 
Ink Drying Time.

Note:
If you are printing high-density data, such as photos or graphs, we recommend adjusting the 
Print Density.

17.Load paper into the printer, and click Print.

& See “Loading Paper” on page 21.

Folded Booklet Double-sided Printing (for Windows only)

Manual double-sided printing

Use the following steps to create a folded booklet.

Note:
Folded booklet double-sided printing function is available only when manual double-sided printing 
is set.
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1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings:

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages

❏ Text & Image for higher quality pages with text and images

❏ Graphic for higher quality graphics

❏ Photo for good quality and speed

3. Select Rear Tray as the Source setting.

4. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 28.
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5. Select the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab and select Manual under 2-sided Printing. Then select the 
Folded Booklet check box.

8. Click Margins to open the Margins window.
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9. Specify the edge of the paper where the binding will be placed. You can choose Left, 
Top, or Right.

Note:
When you select Portrait as the Orientation setting, the Left or Right binding positions are 
available. The Top binding position is available when you select Landscape as the Orientation 
setting.

10.Choose cm or inch as the Unit setting. Specify the width of the binding margin.

* : Folding edge

** : Margin

You can enter any width from 0.12 to 1.18 inches, or from 0.3 to 3.0 cm. The specified 
margin width will be used on both sides of the fold. For example, if you specify a 1 inch 
margin, you will get a 2 inch margin (a margin of 1 inch will be placed on each side of 
the fold).

11.Click OK to return to the Page Layout window. Then click OK to save your settings.

12.Load paper into the rear sheet feeder, then send the print job from your application. 
Instructions for printing the inside pages will be displayed while the outside pages are 
printed.

& See “Loading Paper” on page 21.

13.Follow the on-screen instructions to reload the paper.

Note:
❏ The paper may curl during printing due to the amount of ink used. Should this occur, slightly 

curl the sheets in the opposite direction before reloading them.

❏ Align the sheet stack by tapping its edges against a hard, flat surface before reloading it in 
the printer.

Portrait Landscape



Printing with Special Layout Options 73

❏ Follow the instructions provided when reloading the printouts. Otherwise, paper may jam or 
the binding margins may be incorrect.

❏ If a paper jam occurs, refer to the following.
& See “The Paper Jams” on page 148.

14.Once the paper is reloaded, click Resume to print the inside pages.

15.Once printing is complete, fold the sheets and bind them together using a stapler or 
other binding method.

Fit to Page Printing

You can use the Fit to Page printing function when you want to print, for example, a letter 
size document on another size paper.

Fit to Page printing automatically resizes your page to the paper size you select. You can 
also resize your page manually.

Printer Settings for Windows

1. Access the printer settings.
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& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings:

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages

❏ Text & Image for higher quality pages with text and images

❏ Graphic for higher quality graphics

❏ Photo for good quality and speed

3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

5. Select the appropriate Size setting.
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6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, then select the Reduce/Enlarge Document check box.

8. Do one of the following:

❏ If you selected By Output Paper Size, select the size of the paper you are using 
from the drop-down list.

❏ If you selected By Percentage, use the arrows to choose a percentage.

9. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Printer Settings for Mac OS X 10.5 and 10.6

1. Access the Print dialog.
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& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the d button to extend this dialog.

3. Select the printer you are using as the Printer setting, and then make suitable settings.

Note:
Depending on your application, you may not be able to select some of the items in this dialog. 
If so, click Page Setup on the File menu of your application, and then make suitable settings.
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4. Select Paper Handling from the pop-up menu.

5. Select the Scale to fit paper size.

6. Make sure that the appropriate size is displayed in Destination Paper Size.
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7. Select Print Settings from the pop-up menu.

8. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Printer Settings for Mac OS X 10.4

1. Access the Page Setup dialog.
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& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Select the printer you are using as the Format for setting and then make suitable 
settings.

3. Click OK to close the Page Setup dialog.

4. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

5. Select the printer you are using as the Printer setting, then make the Copies & Pages 
settings.
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6. Select Paper Handling from the pop-up menu.

7. Select Scale to fit paper size as the Destination Paper Size.

8. Select the appropriate paper size from the pop-up menu.

9. Select Print Settings from the pop-up menu.

10.Make the settings that you want to use to print. See online help for details of Print 
Settings.
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& See “Selecting the Correct Paper Type or Media Type” on page 28.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Pages Per Sheet Printing

Pages Per Sheet printing allows you to print two or four pages on single sheets of paper.

Printer Settings for Windows

1. Access the printer settings.
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& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings:

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only pages

❏ Text & Image for higher quality pages with text and images

❏ Graphic for higher quality graphics

❏ Photo for good quality and speed

3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

5. Select the appropriate Size setting.
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6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, select Multi-Page, then select Pages Per Sheet.

8. Select from the following settings for Pages Per Sheet printing:

9. Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

2, 4 Prints two or four pages of your document on a single piece of 
paper.

Print Page 
Borders

Prints frames around the pages printed on each sheet.

Page Order Allows you to specify the order in which the pages will be printed on 
the sheet of paper. Some settings may be unavailable, depending 
on the Orientation setting on the Main window.
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Printer Settings for Mac OS X 10.5 and 10.6

1. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the d button to extend this dialog.

3. Select the printer you are using as the Printer setting, and then make suitable settings.

Note:
Depending on your application, you may not be able to select some of the items in this dialog. 
If so, click Page Setup on the File menu of your application, and then make suitable settings.
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4. Select Layout from the pop-up menu.

5. Select from the following settings:

Pages per 
Sheet

Prints multiple pages of your document on a single piece of paper.

You can choose from 1, 2, 4, 6, 9, or 16. 

Layout 
Direction

Allows you to specify the order in which the pages will be printed on 
the sheet of paper. 

Border Prints a border around the pages printed on each sheet. You can 
choose from None, Single Hairline, Single Thin Line, Double Hairline, 
or Double Thin Line.
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6. Select Print Settings from the pop-up menu.

7. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Printer Settings for Mac OS X 10.4

1. Access the Page Setup dialog.
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& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Select the printer you are using as the Format for setting, and then make suitable 
settings.

3. Click OK to close the Page Setup dialog.

4. Access the Print dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

5. Select the printer you are using as the Printer setting, then make the Copies & Pages 
settings.
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6. Select Layout from the pop-up menu.

7. Select from the following settings:

Pages per 
Sheet

Prints multiple pages of your document on a single piece of paper. 
You can choose from 1, 2, 4, 6, 9, or 16.

Layout 
Direction

Allows you to specify the order in which the pages will be printed on 
the sheet of paper.

Border Prints a border around the pages printed on each sheet. You can 
choose from None, Single Hairline, Single Thin Line, Double Hairline, 
or Double Thin Line.
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8. Select Print Settings from the pop-up menu.

9. Make the settings that you want to use to print. See online help for details of Print 
Settings.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Poster Printing (for Windows only)

Poster printing allows you to print poster-size images by enlarging one page to cover 
several sheets of paper.
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Printer Settings

1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings: 

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only documents

❏ Text & Image for higher quality pages with text and images

❏ Graphic for higher quality graphics

❏ Photo for good quality and speed

3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.
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& See “Selecting the Correct Paper Type or Media Type” on page 28.

5. Select the appropriate Size setting.

6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab and select Multi-Page, then select Poster Printing. Click 
the up or down arrow to select 2x1, 2x2, 3x3, or 4x4.
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8. Click Settings to adjust the way your poster will be printed. The Poster Settings window 
opens.

9. Make the following settings:

Note:
If you want to print only a few of the panels without printing the entire poster, click the panels 
that you do not want to print.

10.Click OK to close the Poster Settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job. Then follow the instructions.
& See “How to Make a Poster from Your Printouts” on page 93.

Print Cutting 
Guides

Prints guide lines for cutting.

Overlapping 
Alignment 
Marks

Slightly overlaps the panels and prints alignment markers so that the 
panels can be aligned more precisely.

Trim Lines Prints border lines on the panels to guide you when trimming the 
pages.
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How to Make a Poster from Your Printouts

Here is an example of how to make a poster with 2x2 selected under Poster Printing and 
Overlapping Alignment Marks selected as the Print Cutting Guides.

1. Cut off the margin of Sheet 1 along a vertical line through the center of the top and 
bottom cross marks: 

2. Place the edge of Sheet 1 on top of Sheet 2 and align the cross marks, then temporarily 
tape the two sheets together from the back:

3. Cut the taped sheets in two along a vertical line through the alignment markers (this 
time, a line to the left of the cross marks):
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4. Align the edges of the paper using the alignment markers and tape them together from 
the back:

5. Repeat the instructions from step 1 to step 4 to tape Sheets 3 and 4 together.

6. Repeat the instructions from step 1 to step 4 to tape the top and bottom edges of the 
paper:

7. Cut off the remaining margins.

Watermark Printing (for Windows only)

Watermark printing allows you to print a text-based or image-based watermark on your 
document.
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Printing the Watermark

1. Access the printer settings.

& See “Accessing the Printer Driver for Windows” on page 14.

2. Click the Main tab, then select one of the following Quality Option settings: 

❏ Draft for rough drafts with reduced print quality

❏ Text for text-only documents with higher text quality

❏ Text & Image for higher quality documents with text and images

3. Select the paper source as the Source setting.

4. Select the appropriate Type setting.

& See “Selecting the Correct Paper Type or Media Type” on page 28.

5. Select the appropriate Size setting.
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6. Select Portrait (tall) or Landscape (wide) to change the orientation of your printout.

7. Click the Page Layout tab, choose the desired watermark from the Watermark list, then 
click Settings.

If you want to create your own watermark, see the following instructions.
& See “Creating Your Own Watermark” on page 97.
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8. Specify the settings you want for the watermark. You can change the position and size 
of the watermark by dragging the image within the preview window.

9. Click OK to return to the Page Layout window.

10.Click OK to close the printer settings window.

After completing the steps above, print one test copy and examine the results before 
printing an entire job.

Creating Your Own Watermark

You can add your own text-based or image-based watermarks to the Watermark list.
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1. Click Add/Del under Watermark on the Page Layout window. The following window 
appears.

2. Do one of the following:

❏ To use an image file as a watermark, select BMP. Click Browse to locate the bitmap 
file you want to use, then click Open. Type a name for your watermark in the Name 
text box, then click Save.

❏ To create a text-based watermark, select Text. Type your text in the Text box. This 
text will also be used as the watermark name. If you want to change the watermark 
name, type a new name in the Name text box, then click Save.

3. Click OK to return to the Page Layout window.
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4. Click Settings. The following window appears: 

5. Make sure that the appropriate watermark is selected in the Watermark list, then select 
Color, Position, Density, Size, Font, Style, and Angle settings. (For details, see the 
online help.) Your settings are reflected in the preview window.

6. When you finish making settings, click OK.
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Chapter 5 

Using the Control Panel

Introduction

You can use the printer’s control panel to access a variety of menus that allow you to check 
the status of consumable products, print status sheets, and make printer settings. This 
section describes how to use the control panel.

The Control Panel

The control panel of the printer consists of 7 buttons, 3 lights, and a liquid crystal display 
(LCD).

Buttons and Lights

The table below describes the functions of the buttons on the control panel.

Button Description
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The table below describes the meanings of the lights on the control panel. The lights let you 
know the status of the printer and the type of an error when it occurs.

Power button

Turns the printer on or off.

Cancel button

Cancels the print job if pressed during printing.

Returns to the Ready status when pressed in Menu mode.

Left button

Returns to the previous level when pressed in Menu mode.

Up button

Changes the parameter in the reverse order when selecting a desired 
parameter in Menu mode.

Down button

Changes the parameters in forward order when selecting a desired 
parameter in Menu mode.

Right button

Enters Menu mode when pressed in the Ready status.

Selects a desired menu when pressed in Menu mode.

OK button

Sets the selected parameter in the selected item in Menu mode.

Executes the item if the selected item is for execution only.

Feeds the paper when paper feed failed.

Light Description
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Icons on the LCD

This section describes the meaning of icons displayed on the LCD screen.

The table below describes the meaning of ink cartridge status icon.

Ink status light 
(orange)

On:
The installed ink cartridge is expended.
The ink cartridge is not installed.
The installed ink cartridges cannot be used with the printer.
The cartridge lock lever is in the unlocked position.
The installed maintenance box is at the end of its service life. 
The maintenance box is not installed.
The installed maintenance box cannot be used with the printer.
The maintenance box cover is open.

Flashing:
The installed ink cartridge is nearly expended.
The maintenance box is nearing the end of its service life.

Paper status light 
(orange)

On:
No paper is loaded in the paper source.
The printer loads more than one sheet of paper at a time.

Flashing:
Paper is jammed.

Power light (green)

On:
The printer is in the Ready status.

Flashing:
The printer is starting.
The printer is printing.
The printer is cleaning the print head.
The printer is charging the ink.
The printer is canceling printing.

Off:
The printer is off.

Icon Description

The icon gives a rough estimate of the useable ink remaining in 
the ink cartridge.

The installed ink cartridge is nearly expended.

The installed ink cartridge is expended.
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The table below describes the meaning of maintenance box status icon.

How to Access the Control Panel Menus

This section describes how to enter Menu mode and make settings with the buttons on the 
control panel.

Note:
❏ Press the + Cancel button whenever you want to exit Menu mode and return to the Ready 

status.

❏ Press the l Left button to return to the previous step.

1. Make sure that READY appears on the LCD screen, and then press the r Right button. 
The first menu appears on the LCD screen.

2. Press the d Down or u Up button to scroll through the menus. 

3. Press the OK or r Right button to select the desired menu. The first item appears on 
the LCD screen.

4. Press the d Down or u Up button to scroll through the items.

5. Press the OK or r Right button to select the desired item. The first parameter appears 
on the LCD screen.

6. Press the d Down or u Up button to scroll through the parameters.

The ink cartridge is not installed.

The installed ink cartridges cannot be used with the printer.

Icon Description

The icon gives a rough estimate of the remaining capacity of 
the maintenance box. The dark graphic reflects remaining 
capacity.

The installed maintenance box is nearing the end of its service 
life.

The installed maintenance box is at the end of its service life.

The maintenance box is not installed.

The installed maintenance box cannot be used with the printer.
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7. Press the OK button to store the selected parameter. If the parameter is for execution 
only, press the OK button to execute the function for the item.

After execution, the printer returns to the previous menu.

8. Press the + Cancel button. The printer returns to the Ready status.

Control Panel Menu List

This section describes the parameter for each item in the menu.

Printer Setting Menu

This menu allows you to configure the basic printer setting.

Language

You can select the language displayed on the LCD screen from the following list: English, 
French, Italian, German, Spanish, Portuguese, Dutch, Japanese.

USB, Network

You can select the printer control language for the port.

Test Print Menu

This menu allows you to make settings related to test print.

Nozzle check

You can print a print head nozzle check pattern for each ink cartridge. From the printing 
results, you can check whether the nozzles are delivering ink properly. 

& See “Checking the Print Head Nozzles” on page 129.

Status sheet

You can print the current printer status. 

& See “Printing the Status Sheet” on page 109.

Network sheet

You can print the current settings of the network interface.
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Printer Status Menu

This menu allows you to check the current printer status.

Version

You can check the firmware version.

Maintenance box

You can get a rough estimate of the remaining capacity of the maintenance box. 

Maintenance Menu

This menu allows you to make settings related to maintenance.

Head alignment

You can print a head alignment test pattern. From the printing results, you can adjust the 
head alignment.

Cleaning

You can clean the print head. You can also print a nozzle check pattern before cleaning.

Auto Cleaning

This printer automatically checks the print head nozzles without printing a pattern and 
cleans the nozzles if they are clogged. Some ink is consumed from all cartridges while 
checking the print head nozzles.

You can turn this function Off or On.

Cleaning sheet

You can clean up the rollers inside the printer.

Contrast adj.

You can adjust the contrast of the LCD screen. Press the u Up or d Down button to adjust 
contrast.

Low Speed Mode

This function may prevent the print head nozzles from becoming clogged, and will print out 
more quietly.
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You can turn this function Off or On.

Network Setting Menu

This menu allows you to make network settings.

Network setup

You can select the method to configure the network settings.

When Auto is selected, the printer obtains the IP address, Subnet mask and Default 
gateway automatically. When Panel is selected, you can specify the IP address, Subnet 
mask, and Default gateway settings using the control panel. When Init N/W set is selected, 
you can revert the network settings of the printer to the factory default value.

IP address, Subnet mask, Default gateway

You can set the IP address, Subnet Mask, and Default Gateway to the printer. To change 
the parameter, press the l Left or r Right button to move cursor and the u Up or d Down 
button to change number.

Bonjour

You can set the Bonjour settings of the printer.

Password Menu

This menu allows you to make settings related to the LCD panel lock.

Password Setting

You can set the password for the LCD panel lock by entering the current password once 
and the new password twice. To enter the password, see “Entering the Password” on page 
109

Note:
❏ The password is set to "" (none) as the factory default.

Item Parameter

Network setup Auto -

Panel IP address 000.000.000.000–255.255.255.255

Subnet mask 000.000.000.000–255.255.255.255

Default gateway 000.000.000.000–255.255.255.255

Init N/W set -
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❏ The password is limited to 8 characters.

❏ Alphanumeric characters are available for the password.

❏ If you forget the password, contact Epson support.

& See “Epson Technical Support” on page 164.

Lock Setting

You can lock the LCD panel to make it childproof, or to prevent unexpected changes made 
by using the LCD panel.

When Ready apears after you set this function On, you need to enter the password when 
you press the r Right button to enter the Menu mode .

Status and Error Messages

This section describes the meaning of messages displayed on the LCD screen.

The table below describes the status messages.

The table below contains error messages, a brief description of each message and 
suggestions for correcting the problem.

Message Description

Cancel The print job is canceled.

Charging ink The printer is charging the ink.

Cleaning The printer is cleaning the print head.

Please wait The printer is starting.

The printer is initializing the settings.

Printing The printer is processing data.

Ready The printer is ready to print.

Power save The printer is in the power save mode.

Power off The printer is shutting down.

Message Problem Solutions

Service call see guide Service call error occurs. Turn off the printer and then back 
on. If the error does not clear, 
contact Epson.

& See “Where To Get Help” on 
page 164.
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Printer near end of 
service life

Parts inside the printer are at the 
end of their service life.

Contact Epson to replace the 
parts.

& See “Where To Get Help” on 
page 164.

Nozzle maint error see 
guide

Print head nozzles are clogged or 
misaligned.

Perform a nozzle check and print 
head cleaning.

& See “Checking the Print Head 
Nozzles” on page 129.

& See “Cleaning the Print Head” 
on page 131.

Press the OK button to recover 
from error status.

Printer error restart 
printer

Printer error occurs. Turn off the printer and make sure 
paper is not jammed. 

& See “The Paper Jams” on page 
148.

If the error still does not clear, 
contact Epson.

& See “Where To Get Help” on 
page 164.

Close maint box 
cover

The maintenance box cover is 
open.

Close the maintenance box 
cover.

Set maint box The maintenance box is not 
installed.

Install the maintenance box.

The maintenance box cannot be 
used with the printer.

Install a genuine maintenance 
box.

Replace maint box The maintenance box is full. Replace the maintenance box.

& See “Replacing the 
Maintenance Box” on page 127.

Move ink lever down The cartridge lever is in the 
unlocked position.

Move the cartridge lever to the 
locked position.

Set ink cartridge The ink cartridge is not installed. Install the ink cartridge.

Replace ink cartridge The ink cartridge cannot be used 
with the printer.

Install a genuine ink cartridge.

The ink cartridge is expended. Replace the ink cartridge.

& See “Replacing an Ink 
Cartridge” on page 120.

Set paper in cassette Paper is not loaded in the front 
paper cassette.

Load the paper in the front paper 
cassette.

Set paper in auto 
feeder

Paper is not loaded in the rear 
sheet feeder.

Load the paper in the rear sheet 
feeder.
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Printing the Status Sheet

While in Menu mode, you can print a status sheet to see the current default values. To print 
a status sheet, follow the steps below.

1. Make sure that letter/A4 size paper is loaded in the front paper cassette.

2. Press the r Right button to enter Menu mode.

3. Press the d Down or u Up button to display TEST PRINT, and then press the OK or 
r Right button.

4. Press the d Down or u Up button to display STATUS SHEET, and then press the OK or 
r Right button.

5. Press the OK button to start printing a status sheet.

After printing is finished, the printer returns to the Test print menu.

Entering the Password

When you want to set or change the password from the Password menu, or press the 
r Right button to enter the Menus after the LCD panel is locked, you need to enter the 
password.

Follow the instuctions below to enter the password.

Note:
If the current password is the factory default, just press the OK button to proceed.

1. Press the d Down or u Up button to display the character you want to select.

Remove jammed 
paper

Paper is jammed in front paper 
cassette or rear sheet feeder.

Remove the jammed paper.

& See “The Paper Jams” on page 
148.

Double feed jam 
remove paper

The printer feeds more than one 
sheet of paper at a time.

Remove the jammed paper, and 
then press the OK button.

Close printer cover The printer cover is open during 
printing.

Close the printer cover.

Set duplex unit The duplex unit is removed. Attach the duplex unit.

Duplex unit jam 
remove paper

Paper is jammed in duplex unit. Remove the jammed paper.

& See “The Paper Jams” on page 
148.
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2. Press the r Right button to determine the character.

3. Repeat steps 1 and 2 until you have entered the password.

4. Once all the characters are set, press the OK button.
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Chapter 6 

Installing Options

Optional Legal-size Paper Support

Installing the Optional Legal-size Paper Support

Align the legal-size paper support with the right side of the paper support and attach it as 
shown. You can load up to 60 sheets of plain legal-size paper (up to 20 lb or 75 g/m²). 

Do not leave legal-size paper in the rear sheet feeder when you are not printing, or the 
sheets may curl. 

Optional Duplex Unit (B-310N only)

Installing the Optional Duplex Unit

Follow the steps below to install the duplex unit.

1. Turn off the printer.

2. Press the hooks on both sides of the upper rear printer cover, and then remove the 
upper rear printer cover.
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Note:
Keep the upper rear printer cover, since it must be in place should you remove the duplexing 
unit later.

3. Insert the bottom side of the duplex unit first, and then attach the duplex unit.

Uninstalling the Optional Duplex Unit

Follow the steps below to uninstall the duplex unit.

1. Turn off the printer.
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2. Remove the duplex unit by pulling it while holding down the buttons on both sides of the 
duplex unit.

3. Attach the upper rear printer cover.

Optional Legal-size Paper Cassette

Installing the Optional Legal-size Paper Cassette

Gently insert the legal-size paper cassette into the front of the printer, underneath the 
paper output tray. The legal-size paper cassette extends past the edge of the paper output 
tray when installed correctly.
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Chapter 7 

Replacing Consumables

Ink Cartridges

Checking the Ink Cartridge Status

Using the Control Panel

To check the ink cartridge status, see “Icons on the LCD” on page 102.

Using the Printer Utility for Windows

Note:
Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink cartridges 
are installed, the ink cartridge status will not be displayed.

To check the ink cartridge status, do one of the following:

❏ Double-click the printer shortcut icon on your Windows taskbar. To add a shortcut icon 
to the taskbar, refer to the following section.
& See “From the Shortcut Icon on the Taskbar” on page 15.

❏ Open the printer driver, click the Maintenance tab, then click the EPSON Status 
Monitor 3 button.
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A graphic displays the ink cartridge status.

Note:
If any of the ink cartridges installed in the printer is broken, incompatible with the printer model, 
or improperly installed, EPSON Status Monitor 3 will not display an accurate calculation of the 
ink cartridge status. Be sure to replace or reinstall any ink cartridges indicated by EPSON 
Status Monitor 3.

❏ The progress meter appears automatically when you start a print job. Click the Check 
Ink Levels button, and then you can check the ink cartridge status from this window.
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Note:
To display the progress meter automatically, click the Maintenance tab in the printer driver 
window, click Speed & Progress, and then select the Show Progress Meter check box.
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Using the Printer Utility for Mac OS X

Note for Mac OS X 10.5 and 10.6:
When an ink cartridge is running low, the Low Ink Reminder window automatically appears. You 
can also check the ink cartridge status from this window. If you do not want to display this window, 
select the Preferences menu from the Application menu when the Low Ink Reminder window is 
displayed, and then clear the Enable Low Ink Reminder check box.

You can check the ink cartridge status using EPSON StatusMonitor. Follow the steps 
below.

1. Access the EPSON Printer Utility3 dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.

Note:
❏ The graphic displays the ink cartridge status when EPSON StatusMonitor was first opened. To 

update the ink cartridge status, click Update.

❏ Epson cannot guarantee the quality or reliability of non-genuine ink. If non-genuine ink 
cartridges are installed, the ink cartridge status may not be displayed.
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❏ If any of the ink cartridges installed in the printer is broken, incompatible with the printer model, 
or improperly installed, EPSON StatusMonitor will not display an accurate status of the ink 
cartridge. Be sure to replace or reinstall any ink cartridge indicated by the EPSON 
StatusMonitor.

Note for Mac OS X 10.5 and 10.6:
The printer monitor window appears automatically when you start a print job. You can check the ink 
cartridge status from this window.

Purchasing Epson Cartridges

You can purchase genuine Epson ink and paper at Epson Supplies Central at 
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an Epson authorized reseller. To find the nearest one, call 
800-GO-EPSON (800-463-7766).

Purchase genuine Epson cartridges and use them within six months of installing them and 
before the expiration date on the cartridge box. When you purchase new ink, use the 
following Epson ink cartridge numbers:

Note:
❏ We recommend that you use genuine Epson cartridges and do not refill them. The use of other 

products may affect your print quality and could result in printer damage.

❏ The printer ships with full cartridges and part of the ink from this first set of cartridges is used for 
charging the printer.

❏ Yields vary considerably based on images printed, print settings, paper type, frequency of use 
and temperature. For print quality, a small amount of ink remains in the cartridge after the 
"replace cartridge" indicator comes on.

❏ Store ink cartridges in a cool, dark place. If cartridges have been exposed to cold temperatures, 
allow them to warm up to room temperature for at least 3 hours before using them.

Handling Precautions

Read all of the instructions in this section before replacing the ink cartridges.

Ink color Standard 
Capacity

High Capacity (B-510DN 
only)

Extra High Capacity (B-510DN 
only)

Black T6161 T6171 T6181

Cyan T6162 T6172 —

Magenta T6163 T6173 —

Yellow T6164 T6174 —

http://www.epson.ca
www.epson.com/ink
www.epson.com/ink
www.epson.ca
www.epson.ca
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❏ This printer uses ink cartridges equipped with an IC chip that monitors the amount of ink 
used by each cartridge. Cartridges are usable even if they are removed and reinserted.

❏ If you need to remove an ink cartridge temporarily, be sure to protect the ink supply 
area from dirt and dust. Store the ink cartridge in the same environment as the printer. 
When storing the cartridge, be sure that its label identifying the color of the ink cartridge 
is facing upward. Do not store ink cartridges upside down.

❏ The valve in the ink supply port is designed to contain any excess ink that may be 
released. However, careful handling is recommended. Do not touch the supply port of 
the ink cartridge or its surrounding area.

❏ Ink is consumed during the following operations: print head cleaning, initial ink 
charging, and nozzle maintaining.

❏ Never turn off the printer during initial ink charging. The ink may fail to be filled up and 
the printer may become unavailable to print.

❏ If you change the ink cartridge to Extra High Capacity Ink Cartridge, retain the default 
ink cartridge or Standard Capacity Ink Cartridge, or High Capacity Ink Cartridge. One of 
these cartridges is needed when you transport the printer.

❏ The use of other products not manufactured by Epson may affect your print quality and 
could result in printer damage that is not covered by Epson’s warranties.

❏ Keep ink cartridges out of the reach of children. Do not allow children to drink the ink or 
handle the cartridges.

❏ Be careful when you handle used ink cartridges, as there may be some ink around the 
ink supply port or surrounding area. If ink gets on your skin, wash the area thoroughly 
with soap and water. If ink gets into your eyes, flush them immediately with water. If 
discomfort or vision problems continue after a thorough flushing, see a doctor 
immediately.

❏ We recommend that you use genuine Epson cartridges and do not refill them. The use 
of other products may affect your print quality and could result in printer damage. Epson 
cannot guarantee the quality or reliability of non-genuine ink. The ink cartridge status is 
not displayed when non-genuine ink is used.

❏ Leave the old cartridge installed in the printer until you have obtained a replacement; 
otherwise, ink remaining in the print head nozzles may dry out.

❏ You cannot continue printing with one ink cartridge expended, even if the other 
cartridges still contain ink. Before printing, replace the expended cartridge.

❏ Never turn off the printer while replacing the ink cartridge. Doing so may damage the IC 
chip on the ink cartridge and the printer may not print properly.
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Replacing an Ink Cartridge

To replace the ink cartridge, follow the steps below.

1. Open the cartridge cover.

2. Move the cartridge lever to the unlocked position.

3. Remove the expended ink cartridge.

Note:
Hold the printer with your hand when you remove the ink cartridge.
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4. Remove the new ink cartridge from the package.

c
Caution:
❏ Do not touch the green IC chip on the side of the cartridge. This can damage the ink 

cartridge.

❏ Always install an ink cartridge immediately after removing the old cartridge. If the 
cartridge is not installed promptly, the print head may dry out and be unable to print.

5. For best results, shake the ink cartridge for about five seconds.
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6. Hold the ink cartridge with the arrow mark facing up and pointing to the rear of the 
printer, and then insert it into the slot.

Note:
Hold the printer with your hand when you install the ink cartridge.

c
Caution:
Do not remove and reinsert cartridges more often than necessary. Doing so can 
compromise the needle valve seal and allow air to enter the ink tubes, causing nozzle 
loss.

7. Move the cartridge lever to the locked position.



Replacing Consumables 123

8. Close the cartridge cover.

Note:
When you install the Extra High Capacity Ink Cartridge, use the printer with the cartridge cover 
opened.

Maintenance Box

Checking the Maintenance Box Status

Using the Control Panel

To check the maintenance box status using the control panel, follow the steps below.

1. Make sure that READY appears on the LCD screen, and then press the r Right button. 
MENU appears on the LCD screen.

2. Press the d Down or u Up button to select PRINTER STATUS, and then press the OK or 
r Right button.

3. Press the d Down or u Up button to select MAINTENANCE BOX, and then press the OK 
or r Right button.

4. A rough estimate of the maintenance box capacity appears on the LCD screen.

Note:
You can check the maintenance box status by the icon displayed on the lower right of the LCD 
screen as well. 
& See “Icons on the LCD” on page 102.
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For Windows

Note:
Epson cannot guarantee the quality or reliability of non-genuine maintenance boxes. If a 
non-genuine maintenance box is installed, the maintenance box status will not be displayed.

To check the maintenance box status, do one of the following:

❏ Double-click the printer shortcut icon on your Windows taskbar. To add a shortcut icon 
to the taskbar, refer to the following section.
& See “From the Shortcut Icon on the Taskbar” on page 15.

❏ Open the printer driver, click the Maintenance tab, then click the Status Monitor 3 
button.
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A graphic displays the maintenance box status.

Note:
❏ The printer ships with a new maintenance box, even though the service life indicator does 

not show 100% when the printer is new. EPSON Status Monitor 3 and the printer’s control 
panel will indicate when the maintenance box needs to be replaced.

❏ If the maintenance box installed in the printer is broken, incompatible with the printer model, 
or improperly installed, EPSON Status Monitor 3 will not display an accurate calculation of 
the maintenance box status. Be sure to replace or reinstall any ink cartridge indicated by 
EPSON Status Monitor 3.

For Mac OS X

You can check the maintenance box status using EPSON StatusMonitor. Follow the steps 
below.

1. Access the EPSON Printer Utility3 dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.
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2. Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.

Note:
❏ The graphic displays the maintenance box status when EPSON StatusMonitor was first 

opened. To update the maintenance box status, click Update.

❏ Epson cannot guarantee the quality or reliability of non-genuine maintenance boxes. If 
non-genuine maintenance boxes are installed, the maintenance box status may not be 
displayed.

❏ If the maintenance box installed in the printer is broken, incompatible with the printer model, or 
improperly installed, EPSON StatusMonitor will not display an accurate status of the 
maintenance box. Be sure to replace or reinstall the maintenance box.

Purchasing a Replacement Maintenance Box

You can purchase a genuine Epson maintenance box at Epson Supplies Central at 
www.epson.com/ink3 (U.S. sales) or www.epson.ca (Canadian sales). You can also 
purchase supplies from an Epson authorized reseller. To find the nearest one, call 
800-GO-EPSON (800-463-7766).

www.epson.com/ink
www.epson.com/ink
www.epson.ca
www.epson.ca
http://www.epson.ca
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Handling Precautions

Read all of the instructions in this section before replacing the maintenance box.

❏ Epson recommends the use of genuine Epson maintenance boxes. The use of a 
non-genuine maintenance box may cause damage that is not covered by Epson’s 
warranties, and under certain circumstances, may cause erratic printer behavior. 
Epson cannot guarantee the quality or reliability of non-genuine maintenance boxes. 
The maintenance box status is not displayed when a non-genuine maintenance box is 
used.

❏ Do not dismantle the maintenance box.

❏ Do not touch the green IC chip on the side of the maintenance box.

❏ Keep out of reach of children, and do not drink the ink.

❏ Do not peel off the film covering the maintenance box.

❏ Do not tilt the used maintenance box until it is placed in the plastic bag provided.

❏ Do not reuse a maintenance box which has been removed and left detached for a long 
period.

Replacing the Maintenance Box

To replace the maintenance box, follow the steps below.

1. Confirm that the printer is ready and not printing.

2. Open the maintenance box cover.

3. Remove the new maintenance box from the package.

4. Lift up and pull the installed maintenance box outward.
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Note:
❏ Do not tilt the maintenance box when you remove it.

❏ Hold the maintenance box with both hands when you handle it.

5. Put the used maintenance box into the plastic bag, and then seal the bag.

Note:
The plastic bag is provided with the new maintenance box.

6. Insert the new maintenance box into place as far as it will go.

7. Close the maintenance box cover.
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Chapter 8 

Maintaining Your Printer

Auto Head Maintenance

This printer automatically checks the print head nozzles without printing a pattern and 
cleans the nozzles if they are clogged (Auto Head Maintenance). You can choose to turn 
this function on or off from the printer’s control panel.

Automatic nozzle checking is performed at predefined times.

Note:
❏ Depending on the circumstances, Auto Head Maintenance may not completely clean the print 

head nozzles.

❏ Some ink is consumed from all cartridges while checking the print head nozzles and cleaning 
the print head.

Checking the Print Head Nozzles

If you find that your printouts are unexpectedly faint or have gaps in them, you may be able 
to identify the problem by checking the print head nozzles.

You can check the print head nozzles from your computer by using the Nozzle Check utility 
or from the printer by using the control panel or buttons.

Note:
The printer checks the print head on a regular basis to keep it clean and make sure you receive 
premium print quality. If print head nozzles are clogged, the printer automatically cleans the print 
head. Normally, you do not need to perform nozzle checks and print head cleaning; however, the 
self-cleaning function cannot completely prevent nozzle clogs.

Using the Nozzle Check Utility for Windows

Follow the steps below to use the Nozzle Check utility.

1. Make sure that no lights are indicating errors.

2. Make sure that letter/A4 size paper is loaded in the front paper cassette.

3. Right-click the printer icon on the taskbar, then select Nozzle Check.
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If the printer icon does not appear, refer to the following section to add the icon.

& See “From the Shortcut Icon on the Taskbar” on page 15.

4. Follow the on-screen instructions.

Using the Nozzle Check Utility for Mac OS X

Follow the steps below to use the Nozzle Check utility.

1. Make sure that no lights are indicating errors.

2. Make sure that letter/A4 size paper is loaded in the sheet feeder.

3. Access the EPSON Printer Utility3 dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

4. Click the Nozzle Check button in the Utility dialog.

5. Follow the on-screen instructions.

Using the Control Panel

Follow the steps below to check the print head nozzles using the control panel.

1. Make sure that letter/A4 size paper is loaded in the front paper cassette.

2. Make sure that READY appears on the LCD screen, and then press the r Right button. 
Menu appears on the LCD screen.

3. Press the d Down or u Up button to select TEST PRINT, and then press the OK or 
r Right button.

4. Press the d Down or u Up button to select NOZZLE CHECK, and then press the OK or 
r Right button.

5. Press the OK button to print the nozzle check pattern.

After printing, the cleaning menu appears. If you find a print quality problem, press the 
OK button to clean the print head.
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Cleaning the Print Head

If you find that your printouts are unexpectedly faint or have gaps in them, you may be able 
to solve these problems by cleaning the print head, which ensures that the nozzles are 
delivering ink properly.

You can clean the print head from your computer using the Head Cleaning utility in the 
printer driver or from the printer by using the control panel or buttons.

Note:
❏ Clean the print head only if print quality declines; for example, if the printout is blurry or the color 

is incorrect or missing.

❏ Use the Nozzle Check utility first to confirm that the print head needs to be cleaned. This saves 
ink.

❏ When ink is low you may not be able to clean the print head. When ink is expended you cannot 
clean the print head. Replace the appropriate ink cartridge first.
& See “Replacing an Ink Cartridge” on page 120.

Using the Head Cleaning Utility for Windows

Follow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure the printer is turned on.

2. Make sure that no lights are indicating errors.

3. Make sure that letter/A4 size paper is loaded in the front paper cassette.

4. Right-click the printer icon on the taskbar, then select Head Cleaning.

If the printer icon does not appear, refer to the following section to add the icon.

& See “From the Shortcut Icon on the Taskbar” on page 15.

5. Follow the on-screen instructions.

The P Power light flashes while the printer performs the cleaning cycle.

c
Caution:
Never turn off the printer while the P Power light is flashing. Doing so may damage the 
printer.

Note:
❏ If print quality has not improved after repeating this procedure, turn off the printer and wait for 

at least six hours. Then run the nozzle check again and repeat the head cleaning if necessary.
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❏ If print quality remains a problem, contact Epson.
& See “Where To Get Help” on page 164.

❏ To maintain print quality, we recommend printing a few pages on a regular basis.

Using the Head Cleaning Utility for Mac OS X

Follow the steps below to clean the print head using the Head Cleaning utility.

1. Make sure the printer is turned on.

2. Make sure that no lights are indicating errors.

3. Make sure that letter/A4 size paper is loaded in the sheet feeder.

4. Access the EPSON Printer Utility3.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

5. Click the Head Cleaning button in the Utility dialog.

6. Follow the on-screen instructions.

The P Power light flashes while the printer performs the cleaning cycle.

c
Caution:
Never turn off the printer while the P Power light is flashing. Doing so may damage the 
printer.

Note:
❏ If print quality has not improved after repeating this procedure about four times, turn the printer 

off and wait for at least six hours. Then run the nozzle check again and repeat the head cleaning 
if necessary. If print quality has still not improved, contact your dealer.

❏ To maintain print quality, we recommend printing a few pages on a regular basis.

Using the Control Panel

Follow the steps below to clean the print head using the control panel.

1. Make sure that letter/A4 size paper is loaded in the front paper cassette.

2. Make sure that READY appears on the LCD screen, and then press the r Right button. 
Menu appears on the LCD screen.
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3. Press the d Down or u Up button to select MAINTENANCE, and then press the OK or 
r Right button.

4. Press the d Down or u Up button to select CLEANING, and then press the OK or 
r Right button.

5. Press the OK button to start cleaning. The P Power light begins flashing.

c
Caution:
Never turn off the printer while the P Power light is flashing. Doing so may damage the 
printer.

6. When the P Power light stops flashing, the printer returns to the nozzle check menu. 
Press the OK button to print a nozzle check pattern to confirm that the head is clean.
& See “Checking the Print Head Nozzles” on page 129.

Note:
❏ If print quality has not improved after repeating this procedure, turn off the printer and wait for 

at least six hours. Then run the nozzle check again and repeat the head cleaning if necessary.

❏ If print quality remains a problem, contact Epson.
& See “Where To Get Help” on page 164.

❏ To maintain print quality, we recommend printing a few pages on a regular basis.

Aligning the Print Head

If you notice a misalignment of vertical lines or horizontal banding, you may be able to 
solve this problem by using the Print Head Alignment utility in your printer driver or from the 
printer by using the buttons.

Refer to the appropriate section below.

Note:
Do not press the + Cancel button to cancel printing while printing a test pattern with the Print Head 
Alignment utility.

Using the Print Head Alignment Utility for Windows

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that no lights are indicating errors.

2. Make sure letter/A4 size plain paper is loaded in the front paper cassette.
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3. Right-click the printer icon on the taskbar, then select Print Head Alignment.

If the printer icon does not appear, refer to the following section to add the icon.

& See “From the Shortcut Icon on the Taskbar” on page 15.

4. Follow the on-screen instructions to align the print head.

Using the Print Head Alignment Utility for Mac OS X

Follow the steps below to align the print head using the Print Head Alignment utility.

1. Make sure that no lights are indicating errors.

2. Make sure letter/A4 size paper is loaded in the sheet feeder.

3. Access the EPSON Printer Utility3 dialog.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

4. Click the Print Head Alignment button in the Utility dialog.

5. Follow the on-screen instructions to align the print head.

Using the Control Panel

Follow the steps below to align the print head using the control panel.

1. Make sure that letter/A4 size plain paper is loaded in the front paper cassette.

2. Make sure that READY appears on the LCD screen, and then press the r Right button. 
Menu appears on the LCD screen.

3. Press the d Down or u Up button to select MAINTENANCE, and then press the OK or 
r Right button.

4. Press the d Down or u Up button to select HEAD ALIGNMENT, and then press the OK or 
r Right button.

5. Press the OK button to print the alignment pattern.

6. Look at the alignment patterns and find the square without any visible bands in sets #1 
through #4.
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7. Press the d Down or u Up button to select the number that corresponds to the square 
for sets #1 through #4.

8. Press the OK button to register your selection.

Cleaning Your Printer

To keep your printer operating at its best, clean it thoroughly several times a year.

w
Warning:
Be careful not to touch the parts inside the printer.

c
Caution:
❏ Never use alcohol or thinner to clean the printer. These chemicals can damage the 

printer.

❏ Do not apply grease to the metal parts under the print head.

❏ Be careful to keep water away from the electronic components.

❏ Do not spray the inside of the printer with lubricants.

❏ Unsuitable oils can damage the mechanism. Contact Epson or a qualified service person 
if lubrication is needed.

Note:
After using the printer, close the paper support and the output tray to protect the printer from dust.

Cleaning the Inside of Your Printer

Ink and paper build-up from the rollers may affect the print quality or may prevent the paper 
from feeding smoothly. You can clean the inside of your printer using the control panel.

c
Caution:
Do not wipe the inside of the printer, or small pieces of lint may build up inside the printer.

Using the Control Panel

Follow the steps below to clean the inside of the printer using the control panel.

1. Make sure that letter/A4 size paper is loaded in the front paper cassette.
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2. Make sure that READY appears on the LCD screen, and then press the r Right button. 
MENU appears on the LCD screen.

3. Press the d Down or u Up button to select MAINTENANCE, and then press the OK or 
r Right button.

4. Press the d Down or u Up button to select CLEANING SHEET, and then press the OK or 
r Right button.

5. Press the OK button. The printer feeds and ejects paper.

Repeat these steps until no ink gets on the paper.

Transporting Your Printer

If you need to transport your printer some distance, carefully prepare and repack it as 
described below. Use the original box and packing materials, or a similar box that holds the 
printer snugly.

c
Caution:
When transporting the printer, do not tilt it, stand it up vertically, or turn it upside down. 
Otherwise, ink may leak inside the printer.

1. Plug in the printer and turn it on. Wait until the print head returns to the home position.

2. Press the P Power button to turn off the printer, then unplug its power cord.

c
Caution:
Do not unplug the power cord while the print head is moving or the print head will not 
return to the home position.

3. Disconnect the interface cable.

4. Remove all paper from the printer.

5. Confirm that the cartridge lever is in the locked position and the cartridge cover is 
closed.

c
Caution:
Leave the ink cartridges and maintenance box installed to prevent the ink from leaking.

Note:
If you’re using the Extra High Capacity Ink Cartridge, install a standard- or high-capacity 
cartridge instead when you transport the printer.

6. Close the output tray and paper support.
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7. Attach the protective materials to both sides of the printer.

8. Repack the printer and power cord in the original box.

Note:
❏ Keep the printer level during transport.

❏ Be sure to remove the protective materials from the printer before using it again.

❏ Do not hold the duplex unit when you lift the printer, to prevent the duplex unit from becoming 
detached. Also, make sure that the duplex unit is attached correctly after setting up the printer.

Storing Your Printer

If you need to store your printer, follow the instructions below.

c
Caution:
When storing the printer, do not tilt it, stand it up vertically, or turn it upside down. Otherwise, 
ink may leak inside the printer.

1. Plug in the printer and turn it on. Wait until the print head returns to the home position.

2. Press the P Power button to turn off the printer, then unplug its power cord.

c
Caution:
Do not unplug the printer or turn off the power to the outlet until all the lights are off. 
Otherwise, the print head will not be capped and will dry out during long-term storage.

3. Disconnect the interface cable.

4. Remove all paper from the printer.

5. Confirm that the cartridge lever is in the locked position and the cartridge cover is 
closed.

c
Caution:
Leave the ink cartridges and maintenance box installed to prevent the ink from leaking.

6. Close the output tray and paper support.

Note:
You may need to clean the print head the first time you use the printer after storing it for a long 
period of time.
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Chapter 9 

Using the Printer on a Network

Setting Up the Printer on a Network

This printer can connect anywhere on your network using 10Base-T or 100Base-TX 
because it has a built-in Ethernet interface that supports the TCP/IP protocol.

You can make network interface settings such as IP address by using the printer’s control 
panel, or the applications for your computer.

Using the printer’s control panel

& See “Network Setting Menu” on page 106.
& See also “How to Access the Control Panel Menus” on page 103.

Setting Up Your Computers to Use the Printer

Make sure you have connected the printer to your network as described on the Start Here 
sheet. Then follow the steps below for every computer on the network that will print with the 
B-310N or B510DN.

1. Insert the Software CD-ROM in the CD-ROM drive.

With Windows 7 and Windows Vista, if you see the AutoPlay window, click Run 
Setup.exe. When you see the User Account Control screen, click Continue or Yes.

2. Click Install.
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3. Click Install driver for network connection.

4. Follow the on-screen instructions.

Note:
If the Windows Security Alert window appears, click the Unblock button; otherwise the printer 
will not be listed on the screen of EpsonNet EasyInstall.

5. When you see the following screen, select the printer and click Next.
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6. If you see the following screen, select Automatic. If you need to set the IP address 
manually, select Manual and enter the IP address, subnet mask, and default gateway. 
Then click Next. Follow the instructions on the screen to install the printer driver.

7. When you see the following screen, enter a different name for the printer if you want. If 
you want to print a test page, select the Print test page check box. Click Next.

Note:
If the Windows Security Alert window appears, click the Unblock button.

8. Follow the instructions on the screen to complete the installation.
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9. When you see this screen, click Finish. Then follow the instructions to register your 
printer.

Repeat these steps for every computer on the network that will print with the B-310N or 
B510DN.

Note:
❏ To find the supported OS versions for the printer, see the following section.

& See “Operating System Versions” on page 186.
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Chapter 10 

Troubleshooting

Diagnosing the Problem

Troubleshooting printer problems is best handled in two steps: first diagnose the problem, 
then apply likely solutions until the problem is fixed.

The information that you need to diagnose and solve most common problems is provided 
by online problem solving, the control panel, the EPSON Status Monitor utility, or by 
running a printer operation check. Refer to the appropriate section below.

If you have a specific problem relating to print quality, a printout problem not related to print 
quality, or a paper feeding problem, or if the printer does not print at all, refer to the 
appropriate section.

To solve a problem, you may need to cancel printing.
& See “Canceling Printing” on page 48.

Error Indicators

You can diagnose and solve most problems by checking the error messages on the LCD 
screen. If the printer stops working and displays a message on the LCD screen, refer to the 
section below to diagnose the problem, and then follow the recommended corrective 
measures.

& See “Status and Error Messages” on page 107.

Running a Printer Operation Check

If you are unable to determine the source of the problem, run a printer operation check to 
help you determine whether the problem comes from the printer or your computer.

To run a printer operation check, follow these steps.

1. Make sure both the printer and computer are turned off.

2. Disconnect the cable from the interface connector of the printer.

3. Make sure that letter/A4 size paper is loaded in the front paper cassette.
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4. Turn on the printer and make sure that READY appears on the LCD screen.

5. Press the r Right button to enter Menu mode.

6. Press the d Down or u Up button to display TEST PRINT, and then press the OK or 
r Right button.

7. Press the d Down or u Up button to display NOZZLE CHECK, and then press the OK or 
r Right button.

8. Press the OK button to start printing a nozzle check pattern.

A test page prints showing a nozzle check pattern. If the pattern has gaps, you need to 
clean the print head.
& See “Cleaning the Print Head” on page 131.

❏ If the test page prints, the problem probably lies in your software settings, the cable, or 
your computer. It is also possible that your software may not be installed correctly. Try 
uninstalling your software and reinstalling it.
& See “Uninstalling the Printer Software” on page 16.

❏ If the test page does not print, you may have a problem with your printer. Try the 
suggestions in the following section.
& See “The Printer Does Not Print” on page 160.

Checking Printer Status

For Windows

Note:
When you use your printer as a shared printer on a network with the following combinations of 
computers, the client operating systems are not able to communicate with the printer, so that some 
functions are not available for that particular client.

Server Client

Windows 7/Windows Vista/Windows 
XP/Windows Server 2003/Windows Server 
2008

Windows 2000

Windows 2000 Windows 7/Windows Vista/Windows 
XP/Windows Server 2003/Windows Server 
2008
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Using the Progress Meter

When you send a print job to the printer, the progress meter appears, as shown in the 
illustration below.

The progress meter indicates the progress of the current print job and provides printer 
status information. This window also displays error messages as well as helpful tips for 
better printing. Refer to the appropriate section below.

Tips

Tips for getting the most out of your Epson printer driver appear in the text box of the 
progress meter window. A new tip appears every 15 seconds. For more details on the tip 
displayed in the window, click the Details button.
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Error Messages

If a problem occurs during printing, an error message appears in the text box of the 
progress meter window. For more detailed information, click Online Support to access 
Epson’s support website.

Using EPSON Status Monitor 3

EPSON Status Monitor 3 displays detailed information on the printer status.

There are two ways to access EPSON Status Monitor 3:

❏ Double-click the printer shortcut icon on the Windows taskbar. If the printer icon does 
not appear, refer to the following section to add the icon.
& See “From the Shortcut Icon on the Taskbar” on page 15.
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❏ Open the printer driver, click the Maintenance tab, then click the Epson Status 
Monitor 3 button.

When you access EPSON Status Monitor 3, the following window appears:

EPSON Status Monitor 3 provides the following information:

❏ Ink Status:
EPSON Status Monitor 3 provides a graphic display of the ink status. To see detailed 
information about the ink cartridges, click the Information button.

❏ Maintenance box Status:
EPSON Status Monitor 3 provides a graphic display of the maintenance box status.
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❏ Online Support:
You can access Epson’s support website from EPSON Status Monitor 3. If you 
encounter a problem, click Online Support in the EPSON Status Monitor 3 window.

For Mac OS X

Using EPSON StatusMonitor

If EPSON StatusMonitor detects a printer problem, it will inform you with an error message.

Follow these steps to access EPSON StatusMonitor.

1. Access the EPSON Printer Utility3.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

2. Click the EPSON StatusMonitor button. The EPSON StatusMonitor appears.
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The Paper Jams

c
Caution:
Pull out the jammed paper gently. If you remove the jammed paper with force, torn pieces 
may stay inside the printer or the printer may be damaged.

1. Press the OK button to eject the jammed paper.

2. If the error does not clear, turn off the printer and remove all of the paper inside, 
including any torn pieces. Refer to the appropriate section below.

In the output tray:
Gently pull out the jammed paper forward.

Inside the printer:
Open the front printer cover, and then gently pull out the jammed paper forward.
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In the rear sheet feeder:
Gently pull out the jammed paper upward.

In the front paper cassette:
Close the output tray and pull out the front paper cassette. Then gently pull out the 
jammed paper forward.

Note:
❏ If you cannot pull out the front paper cassette, pull out the output tray first and remove all 

paper that is loaded in the front paper cassette.

Then pull out the front paper cassette and gently pull out the jammed paper forward.
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❏ After you remove the jammed paper and insert the front paper cassette, reinsert the output 
tray into the printer.

In the back of the printer:
Remove the duplex unit (B-510DN) or the upper rear printer cover (B-310N) and open 
the lower rear printer cover. Then gently pull out the jammed paper.
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In the duplex unit:
Remove the duplex unit and open the cover of the duplex unit. Then, gently remove the 
jammed paper.

3. Close the printer cover and turn on the printer.

4. Reload the paper and press the OK button to resume printing.

Note:
If you cannot easily remove a foreign object, do not use force and do not disassemble the printer. 
Contact Epson for assistance.
& See “Where To Get Help” on page 164.

If your paper jams frequently, make sure of the following:

❏ The paper is smooth, not curled or wrinkled.

❏ You are using high quality paper.

❏ The printable side of the paper is face-up in the rear sheet feeder and face-down in the 
front paper cassette.

❏ You fan the paper stack before loading.

❏ The paper is not loaded above the c arrow mark inside the edge guide.

❏ The number of sheets in the paper stack does not exceed the limit specified for that 
paper.
& See “Paper Loading Capacities” on page 20.

❏ The left edge guide is snug against the left edge of the paper.
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❏ The printer is on a flat, stable surface that extends beyond the base in all directions. 
The printer will not operate properly if it is tilted.

Print Quality Problems

If you are having print quality problems, then compare it with the illustrations below. Click 
the caption under the illustration that best resembles your printout.

Good sample Good sample

“Horizontal Banding” on page 153 “Vertical Misalignment or Banding” 
on page 153

“Horizontal Banding” on page 153 “Vertical Misalignment or Banding” 
on page 153

“Incorrect or Missing Colors” on 
page 153

“Blurry or Smeared Printout” on 
page 154
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Horizontal Banding

❏ Make sure the printable side of the paper is face-up in the rear sheet feeder and 
face-down in the front paper cassette.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& See “Cleaning the Print Head” on page 131.

❏ Use up ink cartridges within six months of opening vacuum package.

❏ For best print quality, use genuine Epson ink cartridges.

❏ Check the ink cartridge status.
& See “Checking the Ink Cartridge Status” on page 114.

If the graphic displays the ink is low or expended, replace the appropriate ink cartridge.
& See “Replacing an Ink Cartridge” on page 120.

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See “Selecting the Correct Paper Type or Media Type” on page 28.

Vertical Misalignment or Banding

❏ Make sure the printable side of the paper is face-up in the rear sheet feeder and 
face-down in the front paper cassette.

❏ Run the Head Cleaning utility to clear any clogged ink nozzles.
& See “Cleaning the Print Head” on page 131.

❏ Run the Print Head Alignment utility.
& See “Aligning the Print Head” on page 133.

❏ Clear the High Speed check box from the Advanced window in your printer driver 
(Windows). See the printer driver online help for details.

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See “Selecting the Correct Paper Type or Media Type” on page 28.

Incorrect or Missing Colors

❏ For Windows, clear the Grayscale setting in the Advanced window in your printer 
driver.
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For Mac OS X, change the Color setting to Color in Print Settings dialog in the Print 
dialog of your printer driver.

See the printer driver online help for details.

❏ Adjust the color settings in your application or in your printer driver settings.

For Windows, confirm the settings in the Advanced window.

For Mac OS X, confirm the settings in the Print Settings dialog from the Print dialog.

See the printer driver online help for details.

❏ Run the Head Cleaning utility.
& See “Cleaning the Print Head” on page 131.

❏ Check the ink cartridge status.
& See “Checking the Ink Cartridge Status” on page 114.

If the graphic displays the ink is low or expended, replace the appropriate ink cartridge.
& See “Replacing an Ink Cartridge” on page 120.

❏ If your paper runs out, replace it as soon as possible. If the printer is left without paper 
for a long period of time, the colors of your next print job may be incorrect.

Blurry or Smeared Printout

❏ Use only paper recommended by Epson.
& See “Paper, Consumables, and Options” on page 167.

❏ Make sure the printer is on a flat, stable surface that extends beyond the base in all 
directions. The printer will not operate properly if it is tilted.

❏ Make sure your paper is not damaged, dirty, or too old.

❏ Make sure your paper is dry and the printable side is facing up in the rear sheet feeder 
and facing down in the front paper cassette.

❏ If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite 
direction.

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See “Selecting the Correct Paper Type or Media Type” on page 28.

❏ Remove each sheet from the output tray as it is printed.
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❏ If you are printing on glossy media, place a support sheet (or a sheet of plain paper) 
beneath the stack, or load only one sheet at a time.

❏ Do not touch or allow anything to come into contact with the printed side of paper with 
a shiny finish. To dry your printouts, follow the instructions on the sheet packed with the 
paper.

❏ Run the Head Cleaning utility.
& See “Cleaning the Print Head” on page 131.

Ink Bleeds Through the Page

❏ Use the Print Saturation Adjustment feature to reduce the amount of ink on the page 
and increase the drying time if necessary.
& See “Special Settings for Automatic Double-sided Printing (Using the Duplex Unit)” 
on page 56.

❏ Adjust the ink levels in the photo image.

Miscellaneous Printout Problems

Incorrect or Garbled Characters

❏ Turn off the printer and computer. Make sure the printer’s interface cable is securely 
plugged in.

❏ Clear the print job from the print queue.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 16.

Incorrect Margins

❏ Confirm the margin settings in your application. Make sure that the margins are within 
the printable area of the page.
& See “Printable Area” on page 171.

❏ Make sure the printer driver settings are appropriate for the paper size you are using.

For Windows, confirm the settings in the Main Window.
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For Mac OS X, confirm the settings in the Page Setup dialog or Print dialog.See the 
printer driver online help for details.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 16.

Printout Has a Slight Slant

Make sure that the paper is loaded into the front paper cassette or the rear sheet feeder 
correctly.
& See “Loading Paper” on page 21.

Inverted Image

❏ Clear the Mirror Image check box in the settings from your printer driver, or turn off the 
Mirror Image setting in your application.

For Windows, confirm the settings in the Page Layout window.

For Mac OS X, confirm the settings in the Print Settings dialog in the Print dialog.

For instructions, see the online help for your printer driver or for your application.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 16.

Blank Pages Print

❏ Make sure the printer driver settings are appropriate for the paper size you are using.

For Windows, confirm the settings in the Main window.

For Mac OS X, confirm the settings in the Page Setup dialog or Print dialog.

See the printer driver online help for details.

❏ Confirm the Skip Blank Page setting from your printer driver.

For Windows, click the Speed & Progress button on the Maintenance window.

For Mac OS X, confirm the Extension Settings in the Print dialog.

If it is selected, blank pages in your data are not printed.
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❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 16.

After trying one or more of these solutions, run a printer operation check to check your 
results.
& See “Running a Printer Operation Check” on page 142.

Printed Side is Smeared or Scuffed

❏ If the paper is curled toward the printable side, flatten it or curl it slightly in the opposite 
direction.

❏ Clear the High Speed check box in the settings from your printer driver.

For Windows, confirm the settings in the Advanced window.

For Mac OS X, confirm the settings in the Print Settings dialog in the Print dialog.

See the printer driver online help for details.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 16.

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See “Selecting the Correct Paper Type or Media Type” on page 28.

Printing is too Slow

❏ Make sure the paper type selected in the printer driver is appropriate for the type of 
paper loaded in the printer.
& See “Selecting the Correct Paper Type or Media Type” on page 28.

❏ For Windows, clear all customized settings and select Text as the Quality Option from 
your printer driver’s Main window.

For Mac OS X, clear all customized settings and select Automatic as the Mode and 
move the slider to Speed in the Print Settings dialog in the Print dialog of your printer 
driver. See the printer driver online help for details.

& See “Accessing the Printer Driver for Mac OS X” on page 15.

❏ Close any unnecessary applications.
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❏ If you print continuously for an extended period, the paper may temporarily stop feeding 
or the print head may pause for a while. This is to slow down the printing speed and 
prevent the printer mechanism from overheating and being damaged. If this happens, 
you can continue to print, but we recommend stopping and leaving the printer for about 
thirty minutes with the power on. (The printer does not recover with the power off.) After 
you restart, the printer will print at normal speed. 

❏ This printer checks the print head on a regular basis to keep the print head clean and 
to ensure you receive premium print quality. If the print head nozzles are clogged, the 
printer automatically cleans the print head. During self-checking, and during 
self-cleaning operation, the print speed may decrease.

❏ Make sure Low Speed Mode is not enabled in the printer menu.
& See “Maintenance Menu” on page 105.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 16.

If you try all of the methods above and cannot solve the problem, see the following:
& See “Increasing the Print Speed (for Windows only)” on page 161.

Paper Does Not Feed Correctly

Paper Does Not Feed

Remove the stack of paper and make sure of the following:

❏ The paper is not curled or creased.

❏ The paper is not too old. See the instructions that came with the paper for more 
information.

❏ The paper fits under the c arrow mark inside the edge guide.

❏ Avoid using coated color-laser paper, which can lead to unsatisfactory results.

❏ The number of sheets in the paper stack does not exceed the limit specified for the 
media.
& See “Paper Loading Capacities” on page 20.

❏ Paper is not jammed inside the printer. If it is, remove the jammed paper.
& See “The Paper Jams” on page 148.
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❏ You have followed all special loading instructions that came with your paper. Load the 
paper again.
& See “Loading Paper” on page 21.

Multiple Pages Feed

❏ Make sure the paper stack fits under the c arrow mark inside the edge guide.

❏ Make sure the left edge guide is snug against the left edge of the paper.

❏ Make sure the paper is not curled or folded. If so, flatten it or curl it slightly toward the 
opposite side before loading.

❏ Remove the stack of paper and make sure that the paper is not too thin.
& See “Paper” on page 170.

❏ Fan the edges of the stack to separate the sheets, then reload the paper.

❏ If too many copies of a file are being printed, confirm the Copies setting in your printer 
driver as follows, and also confirm in your application.

For Windows, confirm the Copies setting on the Page Layout window.

For Mac OS X 10.4, confirm the Copies setting in the Copies & Pages setting in the 
Print dialog.

For Mac OS X 10.5 and 10.6, confirm the Copies setting in the Print dialog.

See the printer driver online help for details.

Paper is Improperly Loaded

If you have loaded the paper too far into the printer, the printer cannot feed the paper 
correctly. Turn off the printer and gently remove the paper. Then turn on the printer and 
reload the paper correctly.

Paper is not Ejected Fully or is Wrinkled

❏ Clear the jammed paper as explained in “The Paper Jams” on page 148. Also, check 
the Paper Size setting in your application or printer settings. See the online help for 
details.

❏ If the paper is wrinkled when it comes out, it may be damp or too thin. Load a new stack 
of paper.
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Note:
Store any unused paper in its original packaging in a dry area.

The Printer Does Not Print

All Lights Are Off

❏ Press the P Power button to make sure the printer is on.

❏ Turn off the printer and make sure that the power cord is securely plugged in.

❏ Make sure that your outlet works and is not controlled by a wall switch or timer.

Lights Came On and then Went Out

The printer’s voltage may not match the outlet rating. Turn off the printer and unplug it 
immediately. Then check the label on the back of the printer.

c
Caution:
If the voltage does not match, DO NOT PLUG YOUR PRINTER BACK IN. Contact Epson.
& See “Where To Get Help” on page 164.

The Power Light is On

❏ If no buttons are pressed for 3 minutes, all lights other than the P Power light 
automatically turn off to save energy. Press any button (except the P Power button) to 
return the control panel to its previous state.

❏ If printing with a USB connection, make sure the USB cable is securely connected to 
the printer and to your computer and check that the USB cable is not damaged or badly 
crimped.

❏ If you are using the USB interface, make sure your cable meets the USB 1.1 or 2.0 
standards.

❏ If you are connecting the printer to your computer via a USB hub, connect the printer to 
the first-tier hub from your computer. If the printer driver is still not recognized on your 
computer, try to directly connect the printer to your computer without the USB hub.

❏ If you are connecting the printer to your computer via a USB hub, make sure the USB 
hub device is recognized by your computer.
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❏ Turn off the printer and the computer, disconnect the printer’s interface cable, then print 
an operation check page.
& See “Running a Printer Operation Check” on page 142.

If the check page prints correctly, make sure the printer driver and your application are 
installed correctly.

❏ If you are trying to print a large image, your computer may not have enough memory. 
Try reducing the resolution of your image or printing the image at a smaller size. You 
may need to install more memory in your computer.

❏ Uninstall the printer driver, then reinstall it.
& See “Uninstalling the Printer Software” on page 16.

Increasing the Print Speed (for Windows only)

You can increase print speed by selecting certain settings in the Speed & Progress 
window. Click the Speed & Progress button on your printer driver’s Maintenance window.
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The following dialog box appears.

The table below lists the factors affecting print speed.

For more details on each item, see the online help.

Other Problems

Print Head Cleaning Does Not Start

❏ Make sure that no error indicator lights are on. If any error occurs, recover from the 
error status.
& See “Error Indicators” on page 142.

❏ Make sure that sufficient ink remains for printing. If the ink cartridge is expended, 
replace the cartridge.
& See “Replacing an Ink Cartridge” on page 120.

Print speed Faster Slower

High Speed Copies On Off

Always spool RAW datatype On Off

Page Rendering Mode On Off

Print as Bitmap On Off
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Color Ink is Consumed Even When Printing in Black Ink Only

Not only the black ink but also the color ink is consumed during the following operations: 
print head cleaning and self-cleaning.
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Appendix A 

Where To Get Help

Epson Technical Support

New :Only inkjet, SPC, and Scanner products are used in this section.Visit Epson’s support website for the Epson B-510DN or B-310N for solutions to common 
problems. You can download drivers and documentation, get FAQs and troubleshooting 
advice, or e-mail Epson with your questions.

Speak to a Support Representative

Before you call Epson for support, please have the following information ready:

❏ Product name (Epson B-510DN or B-310N)

❏ Product serial number (located on the back of the printer)

❏ Proof of purchase (such as a store receipt) and date of purchase

❏ Computer configuration

❏ Description of the problem

Then call:

❏ U.S.: (562) 276-7202, 6 AM to 6 PM, Pacific Time, Monday through Friday.

❏ Canada: (905) 709-2567, 6 AM to 6 PM, Pacific Time, Monday through Friday.

Days and hours of support are subject to change without notice. Toll or long distance 
charges may apply.

Purchase Accessories

New :Use Inkjet, SPC, and "other" products Only.(general)You can purchase genuine Epson accessories from an Epson authorized reseller. To find 
the nearest reseller, call 800-GO-EPSON (800-463-7766). Or you can purchase online at 
http://www.epsonstore.com (U.S. sales) or http://www.epson.ca (Canadian sales).

http://www.epson.com/cgi-bin/Store/support/supDetail.jsp?sku=C11CA03091
http://www.epson.com/cgi-bin/Store/support/supDetail.jsp?sku=C11Ca03151
http://www.epsonstore.com/
http://www.epson.ca/
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Appendix B 

Product Information

Printer Parts

B-310N and B-510DN Front View

a. Edge guide: Holds your paper straight in the rear sheet feeder. Move it to the edge of your 
paper.

b. Rear sheet feeder: Feeds paper for printing.

c. Paper support: Supports the paper loaded in the rear sheet feeder.

d. Front printer cover: Covers the printing mechanism. Open only when the paper jams.

e. Print Head: Prints ink on your paper.
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B-510DN Rear View

f. Control panel: Use the buttons and monitor the LCD screen and lights to control your printer. 
& See “Using the Control Panel” on page 100.

g. Maintenance box cover: Covers the maintenance box. Open only when replacing the 
maintenance box.

h. Output tray: Holds the ejected paper.

i. Front paper cassette: Holds your paper and feeds it for printing.

j. Cartridge lever: Locks the installed ink cartridges.

k. Cartridge cover: Covers the ink cartridges. Open when replacing the ink cartridges. When 
using the extra high capacity ink cartridge, leave opened.

a. USB connector: Connects the USB cable from your computer to the printer.

b. Ethernet connector: Connects the 10Base-T/100Base-TX cable from your computer to the 
printer.

c. Duplex unit: Supports automatic double-sided printing.

d. AC inlet: Connects the power cord.

e. Rear printer cover: Covers the printing mechanism. Open only when the paper jams.

f. Air vents: Eject heated air from the printer.
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B-310N Rear View

Paper, Consumables, and Options

Paper

Epson offers specially designed paper and other print media for all your printing needs.

a. USB connector: Connects the USB cable from your computer to the printer.

b. Ethernet connector: Connects the 10Base-T/100Base-TX cable from your computer to the 
printer.

c. Upper rear printer cover: Covers the printing mechanism. Open when attaching the duplex 
unit and when the paper jams in the back of the printer.

d. AC inlet: Connects the power cord.

e. Rear printer cover: Covers the printing mechanism. Open only when the paper jams.

f. Air vents: Eject heated air from the printer.
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Note:
You can find the part numbers for the following Epson special papers on the Epson website.
& See “Epson Technical Support” on page 164.

Note:
The availability of paper varies by location.

Ink Cartridges

You can use the following ink cartridges with this printer:

Maintenance Box

You can use the following maintenance box with the B-310N and B510DN:

Duplex Unit (B-310N Users only)

You can use the following duplex unit with the B-310N.

Paper Size Part numbers

Epson Bright White Paper Letter S041586 

Epson Premium Presentation Paper Matte Letter, 8 × 10 S041257, S041467

Epson Premium Presentation Paper Matte 
Double-sided 

Letter S041568

Epson Presentation Paper Matte Letter, Legal S041062, S041067

Epson Photo Quality Self-adhesive Sheets A4 S041106

Ink cartridge Part numbers

B-510DN B-310N

Standard 
capacity

High capacity Extra High 
capacity

Black T6161 T6171 T6181 T6161

Cyan T6162 T6172 – T6162

Magenta T6163 T6173 – T6163

Yellow T6164 T6174 – T6164

Part number

Maintenance Box T619000
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Legal-size Paper Support

You can use the following legal-size paper support with this printer.

Legal-size Paper Cassette

You can use the following legal-size paper cassette with this printer (included with 
B-510DN).

System Requirements

Windows Requirements

To use this printer, you must have any of the following Windows operating systems 
installed. For details on interfaces and operating systems, refer to the following table.

Macintosh Requirements

To connect this printer to a Macintosh computer, you must have any of the following 
Macintosh operating systems installed. For details on interfaces and operating systems, 
refer to the following table.

Part number

Duplex unit C12C802531

Part number

Legal-size paper 
support

C12C815341

Part number

Legal-size paper 
cassette

C12C817001

System PC Interface

Windows 7, Windows Vista, Windows XP, 
Windows 2000, and Windows 2003

USB 2.0 Host Driver by Microsoft must be used.

USB 1.0 and 2.0

Ethernet 100Base-TX/10Base-T
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Technical Specifications

Paper

Note:
❏ Since the quality of any particular brand or type of paper may be changed by the manufacturer 

at any time, Epson cannot attest to the quality of any non-Epson brand or type of paper. Always 
test samples of paper stock before purchasing large quantities or printing large jobs.

❏ Poor quality paper may reduce print quality and cause paper jams or other problems. Laser 
printer coated paper can also cause paper jams. If you encounter problems, switch to a higher 
grade of paper, or stop using laser printer coated paper.

❏ Use paper under normal conditions:
Temperature 59 to 77 °F (15 to 25 °C) 
Humidity 40 to 60% RH 

Single sheets:

Envelopes:

System PC Interface

PowerPC-based or Intel-based Macintosh 
computers running Mac OS X 10.4.11 to 10.6.x

USB 1.0 or 2.0

Ethernet 100Base-TX/10Base-T

Size A4 (8.3 × 11.7 in., 210 × 297 mm)

4 × 6 in. (10 × 15 cm)

A6 (4.1 × 5.8 in., 105 × 148 mm)

Half Letter (5.5 × 8.5 in.)

 8 × 10 in. (20 × 25 cm)

16:9 wide size (4 × 7.11 in., 102 × 181 mm)

Letter 8 1/2 × 11 in.

Legal 8 1/2 × 14 in.

Paper types Plain bond paper or special paper distributed by Epson

Thickness
 (for plain bond 
paper) 

0.003 to 0.005 in. (0.08 to 0.11 mm)

Weight 
(for plain bond 
paper) 

64 g/m² to 90 g/m²

Size Envelope #10 4 1/8 × 9 1/2 in.
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Printable Area

Diagonal lines show printable area.

Single sheets: 

Envelopes:

Paper types Plain bond paper

Weight 75 g/m² to 100 g/m²

Minimum margin

Media type Single sheets Envelopes

A 0.12 in. (3.0 mm) 0.12 in. (3.0 mm)

B-L, B-R 0.12 in. (3.0 mm)  0.20 in. (5.0 mm)

A

C

B-L B-R

A

B-RB-L

C
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Note:
❏ Depending on the type of paper, print quality may decline in the top and bottom areas of the 

printout, or the area may be smeared.

❏ Automatic double-sided printing supports plain paper and Epson Bright White Paper only. 
Minimum bottom margin (C) is 0.63 in. (16 mm) when you use automatic double-sided printing.

Ink Cartridges

* Ink thaws and is usable after approximately 3 hours at 77 °F (25 °C).

Note:
❏ We recommend that you use genuine Epson cartridges and do not refill them. The use of other 

products may affect your print quality and could result in printer damage.

❏ The printer ships with full cartridges and part of the ink from the first cartridges is used for 
priming the printer.

❏ Yields vary considerably based on images printed, print settings, paper type, frequency of use 
and temperature. For print quality, a small amount of ink remains in the cartridge after the 
"replacement cartridge" indicator comes on.

C 0.12 in. (3.0 mm) 0.12 in. (3.0 mm)

Color Yellow, Magenta, Cyan, Black

Cartridge life Use within 6 months of opening the package.

Temperature Storage:
–4 to 104 °F (–20 to 40 °C)
1 month at 104 °F (40 °C)

Freezing:*

8.6 °F (–13 °C) 
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Mechanical

* Loading capacity may decrease if the paper is curled.

Electrical

B-310N and B-510DN

Paper path Front paper cassette, rear sheet feeder

Loading capacity Front paper cassette
About 510 sheets of letter/A4 paper at 75 g/m²*

Front paper cassette (legal-size)
About 510 sheets of legal paper at 75 g/m²*

Rear sheet feeder
About 150 sheets of letter/A4 paper at 75 g/m²*

Using the optional legal-size paper support, about 60 
sheets of legal-size paper at 75 g/m²*

Output tray
About 170 sheets

Dimensions B-510DN

Storage

Width: 18.9 in. (480 mm)

Depth: 21.5 in. (547 mm)

Height: 12.3 in. (312 mm)

Printing

Width: 18.9 in. (480 mm)

Depth: 25.8 in. (656 mm)

Height: 14.6 in. (372 mm)

B-310N

Storage

Width: 18.9 in. (480 mm)

Depth: 16.5 in. (420 mm)

Height: 12.3 in. (312 mm)

Printing

Width: 18.9 in. (480 mm)

Depth: 24.6 in. (624 mm)

Height: 14.6 in. (372 mm)

Weight B-510DN

Approx. 23.6 lb (10.7 kg) (without the ink cartridges)

B-310N

Approx. 21.8 lb (9.9 kg) (without the ink cartridges)
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Note:
Check the label on the back of the printer for its voltage.

Environmental

* Without condensation

Standards and Approvals

U.S. model: 

100-120 V Model 220-240 V Model

Input voltage range AC 90 to 132 V AC 198 to 264 V

Rated frequency range 50 to 60 Hz

Input frequency range 49.5 to 60.5 Hz

Rated current 0.7 A 0.4 A

Power 
consumption

Printing Approx. 30.0 W

(ISO/IEC10561 
Letter Pattern)

Approx. 30.0 W

(ISO/IEC10561 
Letter Pattern)

Ready mode Approx. 6.5 W Approx. 7.0 W

Sleep mode Approx. 3.5 W Approx. 3.5 W

Power off Approx. 0.2 W Approx. 0.4 W

Temperature Operation:
50 to 95 °F (10 to 35 °C)

Storage: 
–4 to 104 °F  (–20 to 40 °C)

1 month at 104 °F (40 °C)

Humidity Operation:* 
20 to 80% RH

Storage:* 5 to 85% RH

Safety UL60950-1
CAN/CSA-C22.2 No. 60950-1

EMC FCC Part 15 Subpart B Class B
CAN/CSA-CEI/IEC CISPR 22 Class B
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Interface

Options

Monocolor Preference Mode:

This printer is designed to be used for high-color output.  However, if you usually print using 
black only, you can contact Epson technical support for information about a monocolor 
preference mode available on the printer.  If you decide you want to implement the mode, 
the technical support representative can also help you take the necessary steps to do that.

USB 2.0 Hi-Speed (Device Class for computers)

Ethernet 100BASE-TX/10 BASE-T

Legal size paper support Width: 6.9 in. (176 mm)

Depth: 0.29 in. ( 7.4 mm)

Height: 4.3 in. ( 110 mm)

Weight: Approx. 1.5 oz ( 42 g )

Duplex unit (B-310N only) Width: 12.3 in. (313 mm)

Depth: 6.4 in. (163 mm)

Height: 3.6 in. (92 mm)

Weight: Approx. 1.98 lb (0.9 kg )

Legal-size paper cassette Width: 9.8 in. (250 mm)

Depth: 16.9 in. (430 mm)

Height: 2.8 in. (71 mm)

Weight: Approx. 1.5 lb (0.7 kg )
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FCC Compliance Statement

For United States Users

This equipment has been tested and found to comply with the limits for a Class B digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a residential installation. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause harmful interference to radio or 
television reception. However, there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause interference to radio and television 
reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures:

❏ Reorient or relocate the receiving antenna.

❏ Increase the separation between the equipment and receiver.

❏ Connect the equipment into an outlet on a circuit different from that to which the 
receiver is connected.

❏ Consult the dealer or an experienced radio/TV technician for help.

WARNING

The connection of a non-shielded equipment interface cable to this equipment will 
invalidate the FCC Certification of this device and may cause interference levels which 
exceed the limits established by the FCC for this equipment. It is the responsibility of the 
user to obtain and use a shielded equipment interface cable with this device. If this 
equipment has more than one interface connector, do not leave cables connected to 
unused interfaces. Changes or modifications not expressly approved by the manufacturer 
could void the user’s authority to operate the equipment.

For Canadian Users

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conforme à la norme NMB-003 du Canada.
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Open Source Software License

BSD License (Berkeley Software Distribution License) 

This printer product includes the open source software programs which apply the Berkeley 
Software Distribution License (“BSD Programs”).

These BSD Programs are WITHOUT ANY WARRANTY; without even the implied warranty 
of MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

The Berkeley Software Distribution License UCB BSD is as follows.

Copyright (c) The Regents of the University of California. 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are 
permitted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.

3. Neither the name of the University nor the names of its contributors may be used to 
endorse or promote products derived from this software without specific prior written 
permission.

THIS SOFTWARE IS PROVIDED BY THE REGENTS AND CONTRIBUTORS ``AS IS'' 
AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, 
THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) 

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, 
STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING 
IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.
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Bonjour

This printer product includes the open source software programs which apply the Apple 
Public Source License Version1.2 or its latest version (“Bonjour Programs”).

We provide the source code of the Bonjour Programs pursuant to the the Apple Public 
Source License Version1.2 or its latest version until five (5) years after the discontinuation 
of same model of this printer product. If you desire to receive the source code of the 
Bonjour Programs, please see the “Contacting Customer Support” in Appendix or Printing 
Guide of this User's Guide, and contact the customer support of your region.

You can redistribute Bonjour Programs and/or modify it under the terms of the Apple Public 
Source License Version1.2 or its latest version.

These Bonjour Programs are WITHOUT ANY WARRANTY; without even the implied 
warranty of MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

The Apple Public Source License Version1.2 is as follows. You also can see the the Apple 
Public Source License Version1.2 at http://www.opensource.apple.com/apsl/.

APPLE PUBLIC SOURCE LICENSE 
Version 2.0 - August 6, 2003

1. General; Definitions. This License applies to any program or other work which Apple 
Computer, Inc. ("Apple") makes publicly available and which contains a notice placed by 
Apple identifying such program or work as "Original Code" and stating that it is subject to 
the terms of this Apple Public Source License version 2.0 ("License"). As used in this 
License:

1.1 "Applicable Patent Rights" mean: (a) in the case where Apple is the grantor of rights, (i) 
claims of patents that are now or hereafter acquired, owned by or assigned to Apple and 
(ii) that cover subject matter contained in the Original Code, but only to the extent 
necessary to use, reproduce and/or distribute the Original Code without infringement; and 
(b) in the case where You are the grantor of rights, (i) claims of patents that are now or 
hereafter acquired, owned by or assigned to You and (ii) that cover subject matter in Your 
Modifications, taken alone or in combination with Original Code. 

1.2 "Contributor" means any person or entity that creates or contributes to the creation of 
Modifications. 

1.3 "Covered Code" means the Original Code, Modifications, the combination of Original 
Code and any Modifications, and/or any respective portions thereof.
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1.4 "Externally Deploy" means: (a) to sublicense, distribute or otherwise make Covered 
Code available, directly or indirectly, to anyone other than You; and/or (b) to use Covered 
Code, alone or as part of a Larger Work, in any way to provide a service, including but not 
limited to delivery of content, through electronic communication with a client other than 
You.

1.5 "Larger Work" means a work which combines Covered Code or portions thereof with 
code not governed by the terms of this License.

1.6 "Modifications" mean any addition to, deletion from, and/or change to, the substance 
and/or structure of the Original Code, any previous Modifications, the combination of 
Original Code and any previous Modifications, and/or any respective portions thereof. 
When code is released as a series of files, a Modification is: (a) any addition to or deletion 
from the contents of a file containing Covered Code; and/or (b) any new file or other 
representation of computer program statements that contains any part of Covered Code.

1.7 "Original Code" means (a) the Source Code of a program or other work as originally 
made available by Apple under this License, including the Source Code of any updates or 
upgrades to such programs or works made available by Apple under this License, and that 
has been expressly identified by Apple as such in the header file(s) of such work; and (b) 
the object code compiled from such Source Code and originally made available by Apple 
under this License. 

1.8 "Source Code" means the human readable form of a program or other work that is 
suitable for making modifications to it, including all modules it contains, plus any 
associated interface definition files, scripts used to control compilation and installation of 
an executable (object code).

1.9 "You" or "Your" means an individual or a legal entity exercising rights under this 
License. For legal entities, "You" or "Your" includes any entity which controls, is controlled 
by, or is under common control with, You, where "control" means (a) the power, direct or 
indirect, to cause the direction or management of such entity, whether by contract or 
otherwise, or (b) ownership of fifty percent (50%) or more of the outstanding shares or 
beneficial ownership of such entity. 

2. Permitted Uses; Conditions & Restrictions. Subject to the terms and conditions of this 
License, Apple hereby grants You, effective on the date You accept this License and 
download the Original Code, a world-wide, royalty-free, non-exclusive license, to the extent 
of Apple's Applicable Patent Rights and copyrights covering the Original Code, to do the 
following:

2.1 Unmodified Code. You may use, reproduce, display, perform, internally distribute 
within Your organization, and Externally Deploy verbatim, unmodified copies of the Original 
Code, for commercial or non-commercial purposes, provided that in each instance:

(a) You must retain and reproduce in all copies of Original Code the copyright and other 
proprietary notices and disclaimers of Apple as they appear in the Original Code, and keep 
intact all notices in the Original Code that refer to this License; and 
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(b) You must include a copy of this License with every copy of Source Code of Covered 
Code and documentation You distribute or Externally Deploy, and You may not offer or 
impose any terms on such Source Code that alter or restrict this License or the recipients' 
rights hereunder, except as permitted under Section 6. 

2.2 Modified Code. You may modify Covered Code and use, reproduce, display, perform, 
internally distribute within Your organization, and Externally Deploy Your Modifications and 
Covered Code, for commercial or non-commercial purposes, provided that in each 
instance You also meet all of these conditions: 

(a) You must satisfy all the conditions of Section 2.1 with respect to the Source Code of the 
Covered Code;

(b) You must duplicate, to the extent it does not already exist, the notice in Exhibit A in each 
file of the Source Code of all Your Modifications, and cause the modified files to carry 
prominent notices stating that You changed the files and the date of any change; and 

(c) If You Externally Deploy Your Modifications, You must make Source Code of all Your 
Externally Deployed Modifications either available to those to whom You have Externally 
Deployed Your Modifications, or publicly available. Source Code of Your Externally 
Deployed Modifications must be released under the terms set forth in this License, 
including the license grants set forth in Section 3 below, for as long as you Externally 
Deploy the Covered Code or twelve (12) months from the date of initial External 
Deployment, whichever is longer. You should preferably distribute the Source Code of 
Your Externally Deployed Modifications electronically (e.g. download from a web site).

2.3 Distribution of Executable Versions. In addition, if You Externally Deploy Covered Code 
(Original Code and/or Modifications) in object code, executable form only, You must 
include a prominent notice, in the code itself as well as in related documentation, stating 
that Source Code of the Covered Code is available under the terms of this License with 
information on how and where to obtain such Source Code.

2.4 Third Party Rights. You expressly acknowledge and agree that although Apple and 
each Contributor grants the licenses to their respective portions of the Covered Code set 
forth herein, no assurances are provided by Apple or any Contributor that the Covered 
Code does not infringe the patent or other intellectual property rights of any other entity. 
Apple and each Contributor disclaim any liability to You for claims brought by any other 
entity based on infringement of intellectual property rights or otherwise. As a condition to 
exercising the rights and licenses granted hereunder, You hereby assume sole 
responsibility to secure any other intellectual property rights needed, if any. For example, 
if a third party patent license is required to allow You to distribute the Covered Code, it is 
Your responsibility to acquire that license before distributing the Covered Code.
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3. Your Grants. In consideration of, and as a condition to, the licenses granted to You 
under this License, You hereby grant to any person or entity receiving or distributing 
Covered Code under this License a non-exclusive, royalty-free, perpetual, irrevocable 
license, under Your Applicable Patent Rights and other intellectual property rights (other 
than patent) owned or controlled by You, to use, reproduce, display, perform, modify, 
sublicense, distribute and Externally Deploy Your Modifications of the same scope and 
extent as Apple's licenses under Sections 2.1 and 2.2 above. 

4. Larger Works. You may create a Larger Work by combining Covered Code with other 
code not governed by the terms of this License and distribute the Larger Work as a single 
product. In each such instance, You must make sure the requirements of this License are 
fulfilled for the Covered Code or any portion thereof.

5. Limitations on Patent License. Except as expressly stated in Section 2, no other patent 
rights, express or implied, are granted by Apple herein. Modifications and/or Larger Works 
may require additional patent licenses from Apple which Apple may grant in its sole 
discretion. 

6. Additional Terms. You may choose to offer, and to charge a fee for, warranty, support, 
indemnity or liability obligations and/or other rights consistent with the scope of the license 
granted herein ("Additional Terms") to one or more recipients of Covered Code. However, 
You may do so only on Your own behalf and as Your sole responsibility, and not on behalf 
of Apple or any Contributor. You must obtain the recipient's agreement that any such 
Additional Terms are offered by You alone, and You hereby agree to indemnify, defend 
and hold Apple and every Contributor harmless for any liability incurred by or claims 
asserted against Apple or such Contributor by reason of any such Additional Terms. 

7. Versions of the License. Apple may publish revised and/or new versions of this License 
from time to time. Each version will be given a distinguishing version number. Once 
Original Code has been published under a particular version of this License, You may 
continue to use it under the terms of that version. You may also choose to use such 
Original Code under the terms of any subsequent version of this License published by 
Apple. No one other than Apple has the right to modify the terms applicable to Covered 
Code created under this License.
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8. NO WARRANTY OR SUPPORT. The Covered Code may contain in whole or in part 
pre-release, untested, or not fully tested works. The Covered Code may contain errors that 
could cause failures or loss of data, and may be incomplete or contain inaccuracies. You 
expressly acknowledge and agree that use of the Covered Code, or any portion thereof, is 
at Your sole and entire risk. THE COVERED CODE IS PROVIDED "AS IS" AND 
WITHOUT WARRANTY, UPGRADES OR SUPPORT OF ANY KIND AND APPLE AND 
APPLE'S LICENSOR(S) (COLLECTIVELY REFERRED TO AS "APPLE" FOR THE 
PURPOSES OF SECTIONS 8 AND 9) AND ALL CONTRIBUTORS EXPRESSLY 
DISCLAIM ALL WARRANTIES AND/OR CONDITIONS, EXPRESS OR IMPLIED, 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES AND/OR 
CONDITIONS OF MERCHANTABILITY, OF SATISFACTORY QUALITY, OF FITNESS 
FOR A PARTICULAR PURPOSE, OF ACCURACY, OF QUIET ENJOYMENT, AND 
NONINFRINGEMENT OF THIRD PARTY RIGHTS. APPLE AND EACH CONTRIBUTOR 
DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT OF THE 
COVERED CODE, THAT THE FUNCTIONS CONTAINED IN THE COVERED CODE 
WILL MEET YOUR REQUIREMENTS, THAT THE OPERATION OF THE COVERED 
CODE WILL BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE 
COVERED CODE WILL BE CORRECTED. NO ORAL OR WRITTEN INFORMATION OR 
ADVICE GIVEN BY APPLE, AN APPLE AUTHORIZED REPRESENTATIVE OR ANY 
CONTRIBUTOR SHALL CREATE A WARRANTY. You acknowledge that the Covered 
Code is not intended for use in the operation of nuclear facilities, aircraft navigation, 
communication systems, or air traffic control machines in which case the failure of the 
Covered Code could lead to death, personal injury, or severe physical or environmental 
damage. 

9. LIMITATION OF LIABILITY. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO 
EVENT SHALL APPLE OR ANY CONTRIBUTOR BE LIABLE FOR ANY INCIDENTAL, 
SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR 
RELATING TO THIS LICENSE OR YOUR USE OR INABILITY TO USE THE COVERED 
CODE, OR ANY PORTION THEREOF, WHETHER UNDER A THEORY OF CONTRACT, 
WARRANTY, TORT (INCLUDING NEGLIGENCE), PRODUCTS LIABILITY OR 
OTHERWISE, EVEN IF APPLE OR SUCH CONTRIBUTOR HAS BEEN ADVISED OF 
THE POSSIBILITY OF SUCH DAMAGES AND NOTWITHSTANDING THE FAILURE OF 
ESSENTIAL PURPOSE OF ANY REMEDY. SOME JURISDICTIONS DO NOT ALLOW 
THE LIMITATION OF LIABILITY OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, 
SO THIS LIMITATION MAY NOT APPLY TO YOU. In no event shall Apple's total liability 
to You for all damages (other than as may be required by applicable law) under this 
License exceed the amount of fifty dollars ($50.00).

10. Trademarks. This License does not grant any rights to use the trademarks or trade 
names "Apple", "Apple Computer", "Mac", "Mac OS", "QuickTime", "QuickTime Streaming 
Server" or any other trademarks, service marks, logos or trade names belonging to Apple 
(collectively "Apple Marks") or to any trademark, service mark, logo or trade name 
belonging to any Contributor. You agree not to use any Apple Marks in or as part of the 
name of products derived from the Original Code or to endorse or promote products 
derived from the Original Code other than as expressly permitted by and in strict 
compliance at all times with Apple's third party trademark usage guidelines which are 
posted at http://www.apple.com/legal/guidelinesfor3rdparties.html. 
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11. Ownership. Subject to the licenses granted under this License, each Contributor 
retains all rights, title and interest in and to any Modifications made by such Contributor. 
Apple retains all rights, title and interest in and to the Original Code and any Modifications 
made by or on behalf of Apple ("Apple Modifications"), and such Apple Modifications will 
not be automatically subject to this License. Apple may, at its sole discretion, choose to 
license such Apple Modifications under this License, or on different terms from those 
contained in this License or may choose not to license them at all. 

12. Termination.

12.1 Termination. This License and the rights granted hereunder will terminate:

(a) automatically without notice from Apple if You fail to comply with any term(s) of this 
License and fail to cure such breach within 30 days of becoming aware of such breach;

(b) immediately in the event of the circumstances described in Section 13.5(b); or

(c) automatically without notice from Apple if You, at any time during the term of this 
License, commence an action for patent infringement against Apple; provided that Apple 
did not first commence an action for patent infringement against You in that instance. 

12.2 Effect of Termination. Upon termination, You agree to immediately stop any further 
use, reproduction, modification, sublicensing and distribution of the Covered Code. All 
sublicenses to the Covered Code which have been properly granted prior to termination 
shall survive any termination of this License. Provisions which, by their nature, should 
remain in effect beyond the termination of this License shall survive, including but not 
limited to Sections 3, 5, 8, 9, 10, 11, 12.2 and 13. No party will be liable to any other for 
compensation, indemnity or damages of any sort solely as a result of terminating this 
License in accordance with its terms, and termination of this License will be without 
prejudice to any other right or remedy of any party.

13. Miscellaneous. 

13.1 Government End Users. The Covered Code is a "commercial item" as defined in FAR 
2.101. Government software and technical data rights in the Covered Code include only 
those rights customarily provided to the public as defined in this License. This customary 
commercial license in technical data and software is provided in accordance with FAR 
12.211 (Technical Data) and 12.212 (Computer Software) and, for Department of Defense 
purchases, DFAR 252.227-7015 (Technical Data -- Commercial Items) and 227.7202-3 
(Rights in Commercial Computer Software or Computer Software Documentation). 
Accordingly, all U.S. Government End Users acquire Covered Code with only those rights 
set forth herein. 

13.2 Relationship of Parties. This License will not be construed as creating an agency, 
partnership, joint venture or any other form of legal association between or among You, 
Apple or any Contributor, and You will not represent to the contrary, whether expressly, by 
implication, appearance or otherwise. 
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13.3 Independent Development. Nothing in this License will impair Apple's right to acquire, 
license, develop, have others develop for it, market and/or distribute technology or 
products that perform the same or similar functions as, or otherwise compete with, 
Modifications, Larger Works, technology or products that You may develop, produce, 
market or distribute.

13.4 Waiver; Construction. Failure by Apple or any Contributor to enforce any provision of 
this License will not be deemed a waiver of future enforcement of that or any other 
provision. Any law or regulation which provides that the language of a contract shall be 
construed against the drafter will not apply to this License.

13.5 Severability. (a) If for any reason a court of competent jurisdiction finds any provision 
of this License, or portion thereof, to be unenforceable, that provision of the License will be 
enforced to the maximum extent permissible so as to effect the economic benefits and 
intent of the parties, and the remainder of this License will continue in full force and effect. 
(b) Notwithstanding the foregoing, if applicable law prohibits or restricts You from fully 
and/or specifically complying with Sections 2 and/or 3 or prevents the enforceability of 
either of those Sections, this License will immediately terminate and You must immediately 
discontinue any use of the Covered Code and destroy all copies of it that are in your 
possession or control.

13.6 Dispute Resolution. Any litigation or other dispute resolution between You and Apple 
relating to this License shall take place in the Northern District of California, and You and 
Apple hereby consent to the personal jurisdiction of, and venue in, the state and federal 
courts within that District with respect to this License. The application of the United Nations 
Convention on Contracts for the International Sale of Goods is expressly excluded.

13.7 Entire Agreement; Governing Law. This License constitutes the entire agreement 
between the parties with respect to the subject matter hereof. This License shall be 
governed by the laws of the United States and the State of California, except that body of 
California law concerning conflicts of law.

Where You are located in the province of Quebec, Canada, the following clause applies: 
The parties hereby confirm that they have requested that this License and all related 
documents be drafted in English. Les parties ont exigé que le présent contrat et tous les 
documents connexes soient rédigés en anglais.

EXHIBIT A.

"Portions Copyright (c) 1999-2003 Apple Computer, Inc. All Rights Reserved. 

This file contains Original Code and/or Modifications of Original Code as defined in and 
that are subject to the Apple Public Source License Version 2.0 (the 'License'). You may 
not use this file except in compliance with the License. Please obtain a copy of the License 
at http://www.opensource.apple.com/apsl/ and read it before using this file.
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The Original Code and all software distributed under the License are distributed on an 'AS 
IS' basis, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, AND 
APPLE HEREBY DISCLAIMS ALL SUCH WARRANTIES, INCLUDING WITHOUT 
LIMITATION, ANY WARRANTIES OF MERCHANTABILITY, FITNESS FOR A 
PARTICULAR PURPOSE, QUIET ENJOYMENT OR NON-INFRINGEMENT. Please see 
the License for the specific language governing rights and limitations under the License."
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Operating System Versions

In this manual, the following abbreviations are used.

Windows refers to Windows 7, Windows Vista, XP, Server 2003, Server 2008, and 2000.

Macintosh refers to Mac OS X.

❏ Windows 7 refers to Windows 7 Home Premium Edition, Windows 7 Professional Edition, and 
Windows 7 Ultimate Edition.

❏ Windows Vista refers to Windows Vista Home Basic Edition, Windows Vista Home Premium 
Edition, Windows Vista Business Edition, Windows Vista Enterprise Edition, and Windows Vista 
Ultimate Edition.

❏ Windows XP refers to Windows XP Home Edition, Windows XP Professional x64 Edition, and 
Windows XP Professional.

❏ Windows Server 2008 refers to Windows Server 2008 and Windows Server 2008 x64 Editions.

❏ Windows Server 2003 refers to Windows Server 2003 and Windows Server 2003 x64 Editions.

❏ Windows 2000 refers to Windows 2000 Professional.

❏ Mac OS X refers to Mac OS X 10.4.11, 10.5.x, and 10.6.x.
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A

Accessories, purchasing, 164
Aligning print head, 133

B

Banding, 153
Blank pages, 156
Blurry prints, 154
Booklet printing, 69
Buttons and lights, 100

C

Cable connector, 166, 167
Canceling printing

Mac OS X, 49
Windows, 48

Cartridge
checking status, 114
cover, 166
lever, 166
precautions, 118
purchasing, 118
replacing, 120 to 123

Cleaning
printer, 135
print head, 131

Color problems, 153
Contacting Epson, 164
Control panel

buttons and lights, 100
icons, 102
location, 166
menu list, 104
message, 107
using, 109

D

Documents, printing
Mac OS X 10.4 printer settings, 34
Mac OS X 10.5 and 10.6 printer settings, 32

Windows, 30
Double-sided printing

description, 53
folded booklet, 69
Mac OS X 10.4, 67
Mac OS X 10.5 and 10.6, 61
special settings in Windows, 56
Windows, 55

Driver
accessing for Mac OS X, 15
accessing for Windows, 14
uninstalling, 16

Duplex unit
automatic double-sided printing, 55
installing, 111
location, 166
part number, 168
specifications, 175
uninstalling, 112

E

Edge guide, 165
Enlarging pages, 73
Envelopes

loading, 26
Mac OS X 10.4 printer settings, 46
Mac OS X 10.5 and 10.6 printer settings, 44
printable area, 171
printing, 42
Windows printer settings, 43

Epson
paper, 20
technical support, 164

Error indicators, 142
Ethernet connector, 166, 167

F

Fit to page printing, 73
Folded booklet printing, 69
Front paper cassette

loading, 22

Index
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location, 166

H

Head cleaning, 132
Mac OS X, 132
Windows, 131

Help, Epson, 164
Horizontal banding, 153

I

Incorrect characters, 155
Ink cartridges

checking status in Mac OS X, 117
checking status in Windows, 114
part number, 168
precautions, 118
purchasing, 118
replacing, 120 to 123
specifications, 172

Interface cables, 175

L

Legal size paper casette
part number, 169

Legal size paper cassette
installing, 113

Legal size paper support
installing, 111
part number, 169
specifications, 175

Lights
error indicators, 142

Loading
envelopes, 26
front paper cassette, 22
paper, 20, 21, 22, 24
rear sheet feeder, 24

M

Mac OS X
accessing printer settings, 15
checking printer status, 147
status monitor, 147

Maintenance box
checking status, 123
checking status in Mac OS X, 125
checking status in Windows, 124
cover, 166
part number, 168
purchasing, 126
replacing, 127

Managing print jobs, 143
Margin problems, 155
Media Type, selecting, 28
Menu list

language, 104
maintenance, 105, 106
network, 106
printer setting, 104
printer status, 105
test print, 104

Mirror image, 156
Misalignment, 153
Multiple pages per sheet, 81

N

Network printing, 138
Nozzle check

Mac OS X, 130
Windows, 129

O

Operation check, 142
Output tray

location, 166
setting up, 28

P

Pages per sheet printing, 81
Paper

Epson special paper, 20, 167
feeding problems, 158
loading, 21
loading capacity, 20
loading into front paper cassette, 22
loading into rear sheet feeder, 24
paper support, 165



Index 189

printable area, 171
selecting type, 28
specifications, 170
wrinkling, 159

Paper jams, 148
Part number

duplex unit, 168
ink cartridge, 168
legal size paper casette, 169
legal size paper support, 169
maintenance box, 168

Posters
assembling pages, 93
printing, 89 to 94

Printable area specifications, 171
Printer

checking status, 143
cleaning, 135
front printer cover, 165
operation check, 142
rear printer cover, 166, 167
transporting, 136

Printer settings
accessing for Mac OS X, 15
accessing for Windows, 14

Print head
aligning in Mac OS X, 134
aligning in Windows, 133
checking, 129
cleaning, 131
location, 165

Printing
canceling, 48
double-sided, 53
envelopes, 42
fit to page, 73
folded booklets, 69
multiple pages per sheet, 81
posters, 89 to 94
text, 30
watermarks, 94 to 99

Print quality, improving, 152
Print speed, increasing, 157, 161
Problems

banding, 153

blank pages, 156
blurry prints, 154
contacting Epson, 164
diagnosing, 142
incorrect characters, 155
incorrect colors, 153
ink bleeding through, 155
margins, 155
mirror image, 156
paper feeding, 158
paper jams, 148
printer does not print, 160
print speed, 157
smeared prints, 154, 157

Progress meter, 144

R

Rear sheet feeder
loading, 24
location, 165

Reducing page size, 73
Replacing ink cartridges, 120 to 123
Resizing pages, 73

S

Safety information, 9
Service, 164
Shipping printer, 136
Smeared prints, 154, 157
Software

uninstalling, 16
using, 14 to 19

Specifications
duplex unit, 175
electrical, 173
environmental, 174
ink cartridge, 172
legal size paper support, 175
mechanical, 173
paper, 170
standards and approvals, 174

Speed, increasing, 157, 161
Status Monitor

Mac OS X, 147
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Windows, 145
Status sheet, 109
System requirements, 169

T

Technical support, 164
Text

Mac OS X 10.4, 34
Mac OS X 10.5 and 10.6, 32

Text, printing documents, 30
Transporting printer, 136

U

USB connector, 166, 167
User's Guide, uninstalling, 18

W

Watermark printing, 94 to 99
Windows

accessing printer settings, 14
checking printer status, 143
managing print jobs, 143
status monitor, 145
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